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Step-by-step procedures
The topics below provide step-by-step instructions for working with Asymetrix Digital Video Producer.

Adding a clip to the timeline
Adding and editing titles 
Building a video
Capturing video
Capturing video using an MCIVCR device
Copying a clip
Copying a palette
Importing a media clip
Loading a palette
Marking a clip segment
Modifying a transition effect
Moving a clip on the timeline
Optimizing a palette
Playing a clip
Playing back your video
Previewing a video
Removing a transition effect
Saving a palette
Saving a project
Sending your video to someone
Starting a new project



 Contents (DVP Capture)
Online Help for DVP Capture. Click the topic that you want to know more about.

To use DVP Capture, a video capture board must be installed and configured in your system.
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Technical support contact information

Telephone support
Contact Asymetrix at the telephone numbers listed below for information on telephone support contracts.

Australia/Asia Pacific (61+3) 5255471

Europe (except France and 
Germany), Middle East, Africa, 
Russia

44-923-208-433

UK 0800-716-957 (freephone)

France 05-90-83-19 (freephone)

Germany 01-30-81-27-07 (freephone) 

USA and rest of world 206-637-1600

Online services
Asymetrix provides complimentary support via fax, Asymetrix BBS, CompuServe, America Online, and Internet to 
registered users. Technical support responds to online queries within 48 hours (Monday to Friday).

Technical support fax

Australia/Asia Pacific (61+3) 5255-482
Europe 44-923-208-419
USA 206-454-0672

Asymetrix BBS

Line 1 (1200-2400 baud/9600 baud, 206-451-1173
US Robotics HST mode)

Line 2 (9600-14,400 baud v.32bis) 206-451-8290

America Online

Find Asymetrix in the Industry Connection, 
a subset of the Computing and Software area.

CompuServe

Windows Third Party Developer A forum, section 1 go asymetrix or go winapa
Multimedia Vendors forum, Section 15 go multiven
IBM Ultimedia Tools A forum, Section 5 go ultiatools

Internet

techsup@asymetrix.com
support@asymetrix.com
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New Project
File menu

Closes the current project, prompting you to save changes if necessary, and clears the timeline to start a new 
project.



Step-by-step
Starting a new project

Menu commands
Open Project



Open Project
File menu

Opens an existing DVP project file. Only one project file can be open at a time.

Option Description

File Name Lists the files in the current DVP directory. Select or type the name of the project file you 
want to open. When you click OK, DVP opens the selected file.

List Files Of Type Indicates .PRJ as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Save Project
File menu

Saves the contents of the timeline and the Media Window to the current project file. If the project on which you're 
working has never been saved, this command works the same as the Save Project As command.



Step-by-step
Saving a project



Save Project As
File menu

Saves the contents of the timeline and the Media Window with a DVP project name that you specify.

Option Description

File Name Specifies the name under which the project file will be saved. When you click OK, the file is 
saved with the .PRJ extension. 

List Files Of Type Indicates .PRJ as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Step-by-step
Saving a project



Import Media
File menu

Imports any media files (.AVI, .BMP, .DIB, .FLI, .FLC, .GIF, .PCX, .TGA, .TIF, or .WAV file) that you want to include 
in your project. 

Option Description

File Name Lists all the files in the current default directory. Select or type the name of the media file 
you want to open. Drag to select more than one file, or press Ctrl and click the files you 
want to import. When you click OK, DVP adds the selected file or files to the Media 
Window. 

List Files Of Type Indicates the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.

Preview When clicked, previews the selected .AVI or .WAV media file. If you are previewing an .AVI 
file, click the play forward button after clicking Preview.



Step-by-step
Importing a media clip



Remove Media
File menu

Removes the selected media file from the Media Window and from the timeline. If no media file is selected in the 
Media Window, the command is unavailable.



Media Statistics
File menu

Displays information about the media file that is currently selected in the Media Window. If no media file is selected 
in the Media Window, the command is unavailable.

Choosing this command is the same as double-clicking a media file in the Media Window.

Option Description

Name Name and location of the file.

Media Type Type of media file: video, audio, video and audio, or image.

Length Number of frames in the media file.

Frame Rate Frame rate used to create the media file.

Frame Size Size of the frame in pixels.

Compression Compression method used in the video file.

Format Bit depth of the video or image file.

Type Kind of waveform file (Microsoft WAV or Microsoft PCM). 

Frequency Number of audio samples per second, expressed in hertz (Hz), in the audio file. The higher 
the frequency, the better the sound quality.

Channels Mono or Stereo. Mono plays the same audio through both speakers, while stereo has two 
separate channels.

Sample Size Amount of data in each sample in the audio file. Most desktop applications use 8-bit 
sampling; 16-bit sampling is equivalent to CD-quality sound.



Print To Screen
File menu

Plays the .AVI file selected in the Media Window. 

Option Description

Output Size Frame size of the output video. The option 100% plays the video at its original size; 200% 
plays the video at twice the original size; and Full Screen plays it to fill your screen.

Loop Playback When checked, specifies that the video will automatically repeat when played back. 

Blank Screen For Number of seconds the screen is blank between each repetition (when Loop Playback is 
checked).

Start When clicked, starts the video using the options you specified.

Note: This command does not work with other file formats.



Scaling
File menu

Displays options for how the selected media file should be scaled or cropped to fit the frame size of your video. 
This command is available when a media file is selected in the Media Window.

Option Description

Stretch Video To Output Size Scales the source video so that it fills the frame. If the aspect ratios between the 
source video and the output video differ, DVP stretches the source video to fit the 
output dimensions.

Crop Video To Output Size Plays the source video at its original size, rather than scaling it up or down to the 
frame size. If the source video is larger than the frame size of the output video, 
the video is cropped. 

Cropping When clicked, expands the Scaling dialog box to display cropping controls. This 
button is available only when Crop Video To Output Size is selected.

Drag Outline To Place Video Specifies the position of the output video based on where you drag the outline.

Current Position Specifies the position of the output video based on the coordinates (in pixels) of 
the upper-left corner. The coordinates also display the position of the upper-left 
corner if you drag the outline. 



Exit
File menu

Shortcut

Keyboard: Press Alt+F4

Closes DVP, prompting you to save changes to the current project file if necessary.



Edit menu



Undo
Edit menu

Reverses the last edit you made on the timeline. If the action cannot be undone, this command is unavailable. 



Cut
Edit menu

Shortcut

Keyboard: Press Ctrl+X

Removes the selected media file or overlay from the timeline and temporarily places it on the DVP internal 
clipboard. DVP does not use the Windows Clipboard, so you cannot cut or copy anything to, or paste anything 
from, another Windows program. 

If a portion of a media file is selected on the timeline, only the selected portion is removed; the remaining portion 
either remains in place or moves over to start where the cut portion started, depending on the Cut/Paste option 
setting in the Options dialog box. 

The media file or effect that you cut remains on the internal clipboard until you cut or copy anything else. As long 
as the media file or effect remains on the internal clipboard, you can paste one or more copies back onto the 
timeline.

Choosing this command is the same as clicking the Cut button on the tool bar.



Step-by-step
Copying a clip 

Menu commands
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Duplicate
Paste



Copy
Edit menu

Shortcut

Keyboard: Press Ctrl+C

Copies the selected media file or overlay from the Media Window or the timeline and temporarily places it on the 
DVP internal clipboard. DVP does not use the Windows Clipboard, so you cannot cut or copy anything to, or paste 
anything from, another Windows program. If a portion of a media file is selected on the timeline, only the selected 
portion is copied. 

The media file or effect that you copy remains on the internal clipboard until you cut or copy anything else. As long 
as the media file or overlay remains on the internal clipboard, you can paste one or more copies back onto the 
timeline.

Choosing this command is the same as clicking the Copy button on the tool bar.



Step-by-step
Copying a clip 
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Paste
Edit menu

Shortcut

Keyboard: Press Ctrl+V

Places a copy of a media file or overlay onto the timeline. The media file or overlay must be copied or cut to the 
DVP internal clipboard before you can paste it onto the timeline. DVP does not use the Windows Clipboard, so you 
cannot cut or copy anything to, or paste anything from, another Windows program.

When you paste a media file into an area of the timeline already occupied by another media file, the file you paste 
is either inserted into the existing file or overwrites it, depending on the Cut/Paste option setting in the Options 
dialog box. 

Choosing this command is the same as clicking the Paste button on the tool bar.



Step-by-step
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Duplicate
Edit menu

Specifies the number of copies of a media file or overlay to paste onto the timeline. DVP pastes the copies from 
the clipboard consecutively along the selected timeline track. The media file or overlay must be copied or cut to the 
DVP internal clipboard before you can paste it onto the timeline.

You can also use this command to paste blank frames onto the timeline, for example, to create a black 
background on which you can add a title.

Option Description

Clipboard Contents When checked, specifies that the current contents of the DVP internal clipboard are 
duplicated.

Blank Frame When clicked, specifies that DVP paste blank frames.

Number Of Copies Indicates the number of copies to be pasted. This option is useful, for example, when 
you are pasting a bitmap or blank frame that must cover several frames. The default is 1.



Step-by-step
Copying a clip 
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View menu



Zoom In
View menu

Shortcut

Keyboard: Press (+) on the Numpad

Magnifies the timeline to display it in smaller increments. 

Choosing this command is the same as clicking the Zoom In button on the tool bar.



Menu commands
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Display Current Track Only
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Zoom Out



Zoom Out
View menu

Shortcut

Keyboard: Press ( - ) on the Numpad

Reduces the view of the timeline to display it in larger increments. 

Choosing this command is the same as clicking the Zoom Out button on the tool bar.
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Set Range
View menu

Shortcut

Keyboard: Press Ctrl+R

Determines the starting point and the number of frames to display on the timeline. You can display the current 
range, or set a new range.

Option Description

Start The first frame in the range you want to display.

End The last frame in the range you want to display.

Total The total number of frames you want to view.



Menu commands
Display All Tracks
Display Current Track Only
Zoom In
Zoom Out



Display All Tracks
View menu

When this command is selected, DVP displays all six tracks (Video A, Video B, Trans., Overlay, Audio A, Audio B) 
of the timeline simultaneously, so that as you work with them, you can see how the media files are arranged in 
relation to one another.
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Display Current Track Only
View menu

When this command is selected, DVP displays only the timeline track that currently contains the cursor, so that 
you can work with the media file on that track more easily.



Menu commands
Display All Tracks
Set Range
Zoom In
Zoom Out



Timeline Options
View menu

Specifies whether or not DVP displays thumbnail views of video and audio frames on the timeline. With the Paint 
Video Frames or Paint Audio Frames option selected, you can more easily identify a particular location in a video 
or audio file; with these options off, DVP displays only the first and last thumbnail on the currently visible range, 
and the timeline scrolls more quickly.

Option Description

Paint Video Frames When checked, the timeline displays all thumbnails of the video files. When unchecked, 
the timeline displays only the first and last thumbnail of the visible range.

Paint Audio Frames When checked, the timeline displays thumbnails of the audio files. When unchecked, the 
timeline contains placeholders instead of thumbnails.

Show As Frames When selected, the tick bar on the timeline displays units as frames.

Show As Time When selected, the tick bar on the timeline displays units of time.



Player Options
View menu

Specifies whether to display one Player or both, as well as the size at which each plays back video files. 

Option Description

Visible When checked, the Player is visible in the DVP window.

Zoom Size Specifies the size at which the Player will play back a video. (The size of the 
player does not change until you drag a video file into it.)

Play Video Using DVP Palette When checked, videos play back in the Players using the DVP palette. This 
eliminates potential palette shifts when you use the Players, but does not affect 
the palette of the final video you build.

Play Clip Automatically Specifies that video clips play automatically when you drag them onto the 
Player window. When unchecked, you must click the play forward button to 
preview a video clip in a Player.



Step-by-step
Playing a clip



Effects



Filters
Effects menu

Displays the filters you can apply to the portion of your video that is currently selected on the timeline.

Option Description

All Filters Lists all available filters. Click a filter to select it.

Description Describes the filter that is currently selected in the All Filters list.

Add When clicked, adds the selected filter to the Selected list.

Remove When clicked, removes the selected filter from the Selected list.

Selected Displays the filter or filters that you've added from the All Filters list. You can apply these filters 
to your video by clicking OK in the Filters dialog box.

Options Expands the Filters dialog box to display the Filter Options area, which includes a preview 
window.

Preview Previews the video with the filters in the Selected list applied. 



Reference topics
Filters (descriptions)



Transitions
Effects menu

Displays the transition effect that is currently selected on the timeline, as well as other transitions that you can 
apply instead. If no transition effect is selected, this command is unavailable.

Option Description

All Transitions Lists all available transitions.

Description Describes the transition that is currently selected in the All Transitions list.

Selected Displays the selected transition, which will be applied to the video when you click OK in the 
Transitions dialog box.

Options Expands the Transitions dialog box to display the Transition Options area.

Preview Previews the video with the selected transition applied.



Reference topics
Transitions (descriptions)



Audio Level
Effects menu

Changes the level of the audio in the selected portion of an audio track. 

Use this command to create cross-fades, for example, when you want to fade background music during a 
voiceover.

Option Description

Beginning Level Sets the audio level at the beginning of the selected segment.

Ending Level Sets the audio level at the end of the selected segment.



Titling
Effects menu

Displays the Title Frames dialog box, where you specify the frames that the title will cover in your output video. If 
you select a range of frames on the tick bar or on any track except the Overlay track before choosing this 
command, DVP bypasses the Title Frames dialog box. DVP instead opens the Titling dialog box, where you 
produce or edit text titles for your video. 

Note: When you add a title to a project, DVP places it on the Overlay track in the location you specify. If any other 
title or overlay occupies the same spot on the track, DVP replaces it with the new title. To add several overlays and 
titles in the same location, you must create multiple builds. 

After you specify the title frame length and click OK, the Titling dialog box appears, in which you produce or edit 
text titles for your video. 

Title Frames dialog box

Option Description

Start Of Title Shows the beginning location of the titles. Enter a new number to specify a different 
beginning point.

Length Of Title Shows the number of frames the titles cover. Enter a new number to specify a different title 
length.

Titling dialog box

Option Description

Titles For Selected Frames Lists the titles that you've created.

Edit Title Displays the area in which you can write a new title or edit the title selected in the 
Titles For Selected Frames box.

Start At Frame Shows the first frame in the specified title range. Initially, this frame is the one that 
you selected on the timeline, but you can change the starting frame by entering a 
new frame number.

End At Frame Shows the last frame in the specified title range. Initially, this frame is the one that 
you selected on the timeline, but you can change the ending frame by entering a 
new frame number. 

Total Frames Shows the range of frames that will contain titling. Initially, this number is the 
number of frames that you selected on the timeline, but you can change the range 
by entering a new number. 

Path Displays the Path dialog box, in which you can specify options for moving, 
zooming, and rotating titles and other overlays (see below). This button is 
available after you type a title in the Titles For Selected Frames list. 

Delete (button) Removes selected text without placing a copy on the Windows Clipboard. 

Foreground Color (button) Opens the color palette, in which you specify the color of the text.

Font (button) Displays the Font dialog box, in which you select type specifications for the titling. 
Type specifications apply to all type in a title.

Path dialog box

Option Description

Path (point) Determines the path of the title. You can specify how your title moves by clicking a series 
of points in the dialog box. If you add two or more points, the title moves smoothly from 
one point to the next. To produce the effect of moving a title on- or offscreen, you can 
position points outside the preview thumbnail. 

Note: By default, a title is centered in the video window.

Options When clicked, expands the Path dialog box to display the Path Options area.

Points (buttons) When clicked, adds a point on the path, or removes the selected point from the path. 
Points are added on top of the selected point; you then drag the new point to position it.

Add Indicates whether points are added before or after the selected point. 



Uniform Points When checked, all points are distributed equally over time. If you add a new point, or 
increase the time a selected point occupies, the timing of all other points is modified 
accordingly so that the title still occupies the same amount of time. When unchecked, if 
you add a new point or increase the Get Here or Wait Here frames, DVP removes an 
equal number of frames from the end of the overlay sequence. For details about the Get 
Here and Wait Here options, see their descriptions below.

Set Object's Rotation Indicates the rotation of the selected point. As an overlay moves from one point to 
another point to which you've applied a different rotation, it rotates smoothly from one 
position to the next.

Set Object's Size Indicates the size of the object on the path in pixels. As an overlay moves from one point 
to another point to which you've applied a different size, the object zooms smoothly from 
one size to the next. 

Get Here Indicates the number of frames between the previous point and the selected one. 
Increasing the number of frames causes the title to move more slowly; decreasing the 
number of frames causes the title to move more quickly.

Wait Here Indicates the number of frames the title should remain at a point before moving on to the 
next. You can specify the number of frames by entering a value. 

Preview (buttons) When clicked, DVP steps backward or forward through the titling sequence. You can 
click to move to the beginning or end of the titles, step through one point at time, or step 
through one frame at a time.

Video Indicates whether the thumbnail displays an outline of the video track, or displays the 
video. You can specify what is displayed by selecting Preview Outline or Preview Image. 
Displaying an outline lets you step through a title sequence more quickly, while 
displaying the image can help you coordinate the titling with the action in the video.

Overlay Indicates whether the thumbnail displays the image of the title, an outline of the title, or 
just the point. You can specify what is displayed by selecting Preview Image, Preview 
Outline, or Preview Point. Displaying a preview image provides the most detail about 
how the titles will appear in your video; displaying the outline indicates the size, position, 
and rotation of the title; displaying the point indicates only the location of the center of the 
title.



Overlay Options
Effects menu

Displays options for the video or graphics tracks on the Overlay track, including keying and path information.

Option Description

Preview Displays the current frame in the overlay; by clicking the scroll bar buttons, you 
can proceed through the key frames one frame at a time.

Preview Tracks Specifies which tracks are displayed in the preview window: the video tracks, 
the Overlay track, or both. To view the Overlay track keyed onto the video track, 
click Both.

Key Color (Red, Green, Blue) Displays the key color for the overlay. You specify the color you want by 
entering red, green, and blue (RGB) values, or by clicking a color area in the 
preview window.

Alpha Shows the degree of the overlay's transparency. Adjust the Alpha value, then 
click Preview to view the effects in the preview window.

Tolerance Shows the acceptable deviance from the specified color that will be keyed. 
Tolerance allows colors within a specified range to key correctly. For solid 
backgrounds, such as those in a bitmap or animation, adjusting tolerance may 
not be necessary. For backgrounds that vary slightly in color, such as a live 
video that includes tints of a single color (as in shadow areas), adjust the 
Tolerance value, then click Preview to view the effects in the preview window.

Preview Displays the video, the overlay, or both, depending on the option you select for 
Preview Tracks. You move the scroll bar to view different frames. 

Update When clicked, displays the effects of the current settings in the preview window.

Path Opens the Path dialog box, in which you specify options for moving, zooming, 
and rotating the overlay.

Path dialog box

Option Description

Path (point) Determines the path of the overlay. You can specify how your overlay moves by clicking 
a series of points in this dialog box. If you add two or more points, the overlay moves 
smoothly from one point to the next. To produce the effect of moving an overlay on- or 
offscreen, you can position points outside the preview thumbnail. 

Note: By default, an overlay is centered in the video window.

Options Expands the Path dialog box to display the Path Options area.

Points (buttons) When clicked, adds a point on the path, or removes the selected point from the path. 
Points are added on top of the selected point; you then drag the new point to position it.

Add Indicates whether points are added before or after the selected point. 

Uniform Points When checked, all points are distributed equally over time. If you add a new point, or 
increase the time a selected point occupies, the timing of all other points is modified 
accordingly so that the overlay still occupies the same amount of time. When unchecked, 
if you add a new point or increase the Get Here or Wait Here frames, DVP removes an 
equal number of frames from the end of the overlay sequence. For more details about 
the Wait Here and Get Here options, see their descriptions below.

Set Object's Rotation Indicates the rotation of the selected point. As an overlay moves from one point to 
another point to which you've applied a different rotation, it rotates smoothly from one 
position to the next.

Set Object's Size Indicates the size of the object on the path in pixels. As an overlay moves from one point 
to another point to which you've applied a different size, the object zooms smoothly from 
one size to the next. 

Get Here Indicates the number of frames between the previous point and the selected one. You 
can specify the number of frames by entering a value. Increasing the number of frames 
causes the overlay to move more slowly; decreasing the number of frames causes the 
overlay to move more quickly.

Wait Here Indicates the number of frames the overlay should remain at a point before moving on to 



the next. You can specify the number of frames by entering a value. 

Preview When clicked, DVP steps backward or forward through the titling sequence. You can 
click to move to the beginning or end of the overlay, step through one point at time, or 
step through one frame at a time.

Video Indicates whether the thumbnail displays an outline of the video track, or displays the 
video. You can specify what is displayed by selecting Preview Outline or Preview Image. 
Displaying an outline lets you step through an overlay sequence more quickly, while 
displaying the image helps you coordinate the overlay with the action in the video.

Overlay Indicates whether the thumbnail displays the image of the overlay, an outline of the 
overlay, or just the point. You can specify what is displayed by selecting Preview Image, 
Preview Outline, or Preview Point. Displaying a preview image provides the most detail 
about how the overlay appears in your video; displaying the outline indicates the size, 
position, and rotation of the overlay; displaying the point indicates only the location of the 
center of the overlay.



Video



Preview
Video menu

Shortcut

Keyboard: Press Ctrl+P

Opens a preview window that plays the current contents of all tracks on the timeline.

Option Description

Play forward button Click to play the video. To pause the video, click the button again.

Scroll bar Contains controls for moving the video forward or backward.



Build
Video menu

Displays options for the output video. When you choose options and click OK, DVP builds the video; if you need to 
specify compression, filter, or other options, do so before specifying build options.

Option Description

File Name Displays the location and name (up to eight characters) for the new video file. 
Type the name and location of your video file. Or click Browse to open the Browse 
dialog box, in which you can locate an existing file that you want to overwrite.

Title Type a title to add it to your video. The title is stored as an .AVI file. DVP and other 
programs that use .AVI files, such as Video For Windows, can display the title. 

Description Stored with the video file and displayed in the Media Window if you subsequently 
import the output video you produce back into DVP. The description can also be 
displayed in other programs that use .AVI files, such as Video For Windows. 

Compress All When unchecked, specifies that DVP does not re-compress frames that are 
unchanged. (Changed frames include those you have resized or cropped; or to 
which you have applied a video effect or filter, or made other changes.) 
Compressing only frames that have changed helps speed compression and can 
improve image quality. However, if you have made other changes to the video, 
such as changing the frame rate, you should check this option. 

Warn On Data Rate Failure When checked, warns if the compression rate specified in the Compression dialog 
box is being exceeded as the video is built. Use this option when you need to 
keep the data rate below a certain level. In particular, when your video will be 
played back from a CD-ROM, the data rate should be limited to one a typical CD-
ROM can keep up with. 

Full Optimization When checked, DVP examines the colors in every frame of the source videos, 
and produces a fully-optimized color palette for 8-bit video. This palette option is 
the slowest, but prevents palette shifts during playback of the output video.

Partial Optimization When checked, DVP optimizes only video frames that have changed since you 
last built the video. This option may be faster than Full Optimization, but palette 
shifts may occur during playback of the output video. 

Previous Frame When checked, for any given frame, DVP uses palettes from the source clips. If 
the source clip does not have a palette, DVP uses the palette from the previous 
frame rather than optimizing a new one. This option is faster than Full or Partial 
Optimization, but is likely to produce palette shifts during playback of the output 
video. 

Video Palette When clicked, DVP uses a palette you opened or created. This option appears 
only if you have pasted an 8-bit palette into the video.

Note: Palette options (Full Optimization, Partial Optimization, Previous Frame, and Video Palette) are relevant 
only if you are creating an 8-bit output video. Video and graphics with bit depths greater than 8 bits do not use 
palettes; DVP ignores these settings if the output is at a bit depth greater than 8 bits.

When you click Build, DVP produces the output video. Depending on the size and complexity of the source files, 
the effects you have applied, and the options you have selected, the process of building a video can require a 
significant amount of time. As DVP works, it displays the progress of the build in a preview window.
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Output Format
Video menu

Displays format options for your output video.

Option Description

File Format Displays the file format for your project. In addition to the default format 
(.AVI), DVP can create audio-only .WAV files, video-only .FLI or .FLC files, 
or a series of bitmaps in a variety of formats. 

Size Shows the size of the output video, in pixels. Common sizes for .AVI files 
are 160 by 120, or 320 by 240 (which produces an output file four times as 
large as the smaller size). To change the size of your video, type new 
values for the width and height.

Bit Depth Displays the bit depth options for your video. 

Frame Rate Specifies the number of frames per second for your new video. Video For 
Windows files typically are 15 frames per second (fps), which provides a 
smooth sense of motion. Higher frame rates, up to 30 fps, provide 
smoother motion, but also result in much larger video files. Lower frame 
rates, such as 8 fps, use less data but result in rough, jerky motion.

Maintain Frame 
Numbers

When clicked, DVP includes source video clips on a frame-by-frame basis. 
If you are editing video files that all have the same frame rates, this is the 
best option, because DVP will never drop frames or add additional frames. 
However, if this option is selected when you mix video source files that 
have different frame rates, audio (which is time-dependent) and video from 
a source clip will no longer be synchronized. In this case, Synchronize 
Video may be a better option.

Synchronize Video When clicked, DVP will drop or add video frames as needed to maintain 
the same time as the source clip. This ensures that the audio remains 
synchronized at the new frame rate. You can also use this option to create 
slow-motion and fast-motion effects.

Pad Frames For CD-
ROM Playback

Creates an output video file that plays most efficiently from a CD-ROM. 
Check this option if your output video will be distributed on a CD-ROM.

Channels Specifies Mono or Stereo.

Sample Size Specifies the amount of audio data to be included in each sample. A 16-bit 
sample produces better sound, but larger files.

Frequency Specifies the frequency with which the sound is sampled per second. 
Higher sample rates produce better quality sound, but larger files.

Interleave Audio Every Specifies how often to add audio portions between blocks of video. In most 
cases, the default (every frame) works best. If the audio in the output video 
is choppy, or the video itself delays, you can experiment with different 
settings for this value. (Note If you choose Pad Frames For CD-ROM 
Playback, DVP automatically sets this option to 1 frame to give you the 
best results for CD-ROM playback. You cannot edit this setting unless you 
uncheck Pad Frames For CD-ROM Playback.)

Use Format From First 
Video Input

Specifies that every source video clip you import use the same frame rate, 
frame size, and compression rate as the first video clip you import. When 
unchecked, each video clip you import uses the default settings for these 
options until you choose specific settings. The default settings are: 160 by 
120 pixels (frame size), 15 frames per second (frame rate), and MS Video 
1 (compression). 
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Compression
Video menu

Displays the compression methods you can use for your output video, as well as other options that affect its quality 
and file size.

Option Description

Compressor Lists the compression/decompression routines, called codecs, that come with DVP, or 
that come with your video capture board (if you have one). Choose the one you want 
from the list.

Compression Quality Specifies the compression quality of your video. On a relative scale of 0 (more 
compression, lower quality) to 100 (less compression, higher quality), you can control the 
tradeoff between quality and file size. Higher-quality videos require large files, and may 
take longer to compress.

Key Frame Every Specifies how often key frames are included in your output video. In general, a choice of 
1 key frame for every 15 frames provides a good balance between quality and 
performance. 

Data Rate Determines the data rate, which should correspond to the data rate of the media device 
that will be used to play the output video. Selecting the correct data rate ensures that the 
rate does not exceed the capacity of the media device on which it will be played. In 
particular, CD-ROM drives have relatively low data rates (that is, they're slower than a 
typical hard disk); if you expect to play back your video on a CD-ROM drive, you can limit 
the data rate to that of the CD-ROM drive. 

Configure When checked, displays additional configuration options for the selected compressor, if 
available. 

About Displays version and copyright information about the compression method selected in 
the Compressor box.

Preview Previews the video after compressing it using the selected compression method.
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Play Last Built
Video menu

Plays the most recent output video. This command is available only if you have built a video since you started the 
current session of DVP.



Audio Cross-Fade
Video menu

When checked, automatically cross-fades all audio transitions during the build. If unchecked, the overlapping 
portions of the audio segments are mixed together at normal volume.

Any time two audio segments overlap on the timeline, DVP mixes the end of the first audio clip and the beginning 
of the second. (This transition is similar to the transition between two video segments.)



Reference topics
Sound characteristics



Palette



Open Palette
Palette menu

Displays the available palette files that you can use when you create an 8-bit (256-color) video. When you open a 
palette file, DVP places a copy of the palette on the Windows Clipboard, then prompts you to paste it into the 
current project.

Option Description

File Name Lists the available palette files. Select or type the name of the palette file you want to open; 
when you click OK, DVP opens the selected palette and places it on the Windows 
Clipboard.

List Files Of Type Indicates .PAL as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.
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Save Palette As
Palette menu

Specifies a name and location for a palette file that you want to save. You can then use the palette in other videos. 

For this command to be available, you must first create a palette or paste a palette from the Windows Clipboard. 

Option Description

File Name Displays the file name. Type a file name of up to eight characters; when you click OK, the file 
is saved with the .PAL extension. 

List Files Of Type Indicates .PAL as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Copy Palette
Palette menu

Displays options for copying the palette. 

After you copy a palette, you can paste it into the current project so that the output video uses this palette 
(provided that you build an 8-bit video and the Video Palette option is selected in the Build dialog box).

For this command to be available, the cursor must be located in an 8-bit video, animation, or bitmap on the Video 
A, Video B, or Overlay track.

Option Description

From File Copies the palette from the first selected frame of an 8-bit video on the timeline to the Windows 
Clipboard.

From Video Copies an optimized video palette (if you've created one) to the Windows Clipboard. For this 
option to be available, you must have created and optimized a palette.



Paste Palette
Palette menu

Pastes the palette that is currently on the Windows Clipboard into the current project.

Because DVP pastes the palette from the Windows Clipboard, you can paste a palette from any 8-bit (or less) 
bitmap; open the bitmap in a bitmap editing program, copy it to the Clipboard, open DVP, and paste the palette 
using the Paste Palette command.

This command is unavailable when the Windows Clipboard does not currently contain a palette.



Create Optimal Palette
Palette menu

Optimizes all the colors in a project to an 8-bit palette, so that you can control how DVP creates the palette. Use 
this command to

select a range of the timeline to use as the basis for the optimized palette.
include a background palette in the optimized palette.

Note: DVP offers another way to create an optimized palette. When you build an output video by choosing Build 
from the Video menu, you can select optimization options in the Build dialog box. However, using the Create 
Optimal Palette command provides you with more control over the palette's contents, since you can choose what 
sources the palette is based upon.

Option Description

Whole Video When clicked, specifies that DVP use the whole video as the basis for the palette. Use this 
option when the video contains many different colors in different sections. 

Section When clicked, displays values that specify the range of frames on which to base the palette. 
Use this option when colors are fairly uniform throughout the video. 

Options Displays the Optimization Options dialog box, which lists the colors used in the current 
palette. You can specify how DVP handles background colors.
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Show Current Palettes
Palette menu

Shows the palette that is currently pasted in the video, along with the number of colors it contains.

This command is unavailable if you have not pasted a palette into the video. 



Optimization Options
Palette menu

Displays optimization information and options, which you can use to add a background palette to the project. 

Option Description

System Colors Indicates that Windows reserves 20 colors for its own use.

Background Colors Shows the colors copied from the Windows Clipboard, which DVP will incorporate into 
the palette for the video. (For details, see Set Background below.)

Available Colors Shows the colors available to be extracted from the video.

Background Source Indicates the source of the background colors, if any.

Total Colors Shows the number of colors in the palette.

Set Background Click this option to avoid palette shifts when you play the output video from within 
another program, such as a presentation. With this option selected, DVP incorporates 
the colors used in the other program into your video palette. When this option is 
selected, the source of the background colors appears in the Background Source box. 

Note: To use the Set Background option in the Optimization Options dialog box correctly, you must first copy the 
colors to the Windows Clipboard, or create a palette file that you open in DVP. 



Tools



Video Capture
Tools menu

Opens DVP Capture, which you use to capture video from a VCR, video camera, or videodisc player. 

For DVP Capture to open, a video capture board must be installed and configured in your system.



Options
Tools menu

Specifies what happens when you edit clips on the timeline. The setting you choose appears on the Cut and Paste 
indicators on the timeline.

Option Description

Delete/Insert Clicking Delete/Insert specifies the following: When you cut a portion of a clip from the 
timeline, the following section of the clip moves over to occupy the same time with no gap. 
When you paste a clip on top of another clip, the clip underneath moves to follow the clip 
you paste. 

Erase/Overwrite Clicking Erase/Overwrite specifies the following: When you cut a portion of a clip from the 
timeline, that portion is removed and the other segments remain unaffected. When you 
paste a clip on top of another clip, the clip underneath does not change position; only the 
portion of it that extends beyond the end of the clip you paste will play.

Snap Cuts To End When checked, a clip dragged from the Media Window onto the timeline automatically 
snaps to the end of the last clip. This option can be helpful if you need to sequence clips 
quickly, but it prevents you from positioning a clip in any other location on the timeline. 
(However, you can subsequently drag the clip to a new position, or cut and paste it.)



Glossary
Click a letter to display glossary entries.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A
analog audio
analog video
animation
anti-aliasing
aspect ratio
audio
AVI

B
background palette
bit depth
bitmap
BMP
build

C
CD audio
CD-ROM



chroma-key
Cinepak
clip
clip media
clipboard
codec
compression
cross-fade

D
data rate
delete
device driver
device-independent
DIB
digital audio
digital video
digitize
display device
dithered
drag
DVI
DVP
DVP Capture

E
edit points
8-bit (color)
erase

F
filter
FLI/FLC
font
fps (frames per second)
frame
frame rate
frame size
frequency

G
GIF

H
high-color

I
image
in point
Indeo

J
JPEG

K
key
key color
key frame



keying
Kodak Photo CD

L
lossless
lossy

M
marking
MCI (Media Control Interface)
media device
media device channel
media file
media source
Media Window
MIDI
MPEG
multimedia

N
nonlinear editing
NTSC

O
optimize
optimization
out point
overlay
Overlay track

P
PAL (Phase Alternation by Line)
palette
palette shift
PCX
pixel
play
Player
Point & Click
project

Q
QuickTime

R
RLE

S
sample
scale
scanning
SECAM
segment
smoothing
sound

T
TGA



thumbnail
tick bar
TIF
timecode
timeline
title
track
transition effect

U

V
VCR
video
video capture
video capture board
Video for Windows
videodisc
VISCA
visual media clips
voiceover

W
WAV (wave audio)
waveform

X - Z
zoom



analog audio
The audio signal that comes from an analog audio source, such as an analog audio tape recorder, or sound from a 
videotape player, videodisc player, camera, or television tuner. Unlike digital audio, which represents the audio 
information as bits, analog audio is created by the characteristics of electrical signals transmitted through one or more 
wires. See also digital audio, videodisc.



analog video
The video signal that comes from an analog video source, such as a videotape player, videodisc player, camera, or 
television tuner. Unlike digital video, which represents the video information as patterns of bits, analog video is 
created by the characteristics of electrical signals transmitted through one or more wires. See also digital video, 
videodisc.



animation
A simulation of movement produced by displaying a series of successive images onscreen. 

The two basic kinds of computer animation are frame and cast-based. Frame animation is created by designing a 
separate frame for each screen view, much like a separate individual frame of a filmstrip or videotape. Cast-based 
animation is created by individually designing all of the moving objects to be used through a series of frames; 
assigning each object its own character traits (such as position, pattern, size, and ink); then assembling a complete 
picture frame containing the individual objects. See also digital video.



anti-aliasing
When overlaying graphics or text, a method of blending the edges around the keyed areas. Also called smoothing.



aspect ratio
The relative width and height of a graphic or video window, without regard to its size. For example, a 2-inch by 4-inch 
graphic has the same aspect ratio as one that is 3 inches by 6 inches. 



audio
Recorded sound, such as in a .WAV file, or the sound portion of an .AVI file.



AVI (Audio/Video Interleaved)
A format for storing digital video in a file that alternates blocks of visual and sound information. .AVI files are 
particularly suited for storing on CD-ROM, because their interleaved format lends itself to efficient retrieval with the 
techniques used on CD-ROM drives.



background palette
Colors used in a presentation in which your video will be played. By including background colors in an optimized 8-bit 
palette applied to your video, you can avoid palette shifts when the video is played within the presentation application.



bit depth
The number of bits of color information stored for every video pixel. Standard values for video are 8-bit (up to 256 
colors), 16-bit (up to 65,536 colors, also called high-color), and 24-bit (up to 16.7 million colors, called true-color).



bitmap
An image composed of pixels. Bitmaps are typically used to reproduce images that contain detail, shading, and color, 
such as photographs and film images. You can create bitmaps by using DVP Capture, using paint software, or 
scanning photographs or flat art. 



BMP
The Windows and OS/2 bitmap file format. Identical to .DIB.



build
The process of creating a new video in DVP using the video, sound, bitmaps, and effects assembled on the timeline.



CD audio
Compact disc audio (sometimes called Red Book audio) is sound that is stored digitally (as a series of binary values) 
and converted to analog (continuous sound) within the CD-ROM drive, then played back via the audio cable. 
Because the CD-ROM, and not your computer, converts the data from digital to analog, it does not limit the other 
actions the CPU can simultaneously perform. To use CD audio, you must have a CD-ROM drive and a CD audio 
device driver installed through the Windows Control Panel.



CD-ROM
Compact disc read-only memory.



chroma-key
A type of keying in which the transparency of a particular area is dependent on a key color that you specify. Used to 
superimpose portions of one image on another, such as the image of a television weather reporter superimposed on 
a weather map.



Cinepak
A compression method designed by SuperMac Technologies and included with DVP. Cinepak is a lossy compression 
method.



clip
A reference to a segment of any media source or file that includes a start point, end point, and name. Only the 
reference is stored in DVP. Defining a clip sets the starting and ending points in a media file or media device. 



clip media
Electronic images, music, and video that you can use in your own productions. Commercial clip media is available 
from many sources, such as clip libraries and electronic bulletin boards, and comes on different media, such as 
floppy disk and CD-ROM.



clipboard
A temporary storage location where Windows places the item most recently cut or copied. 

DVP also contains its own internal clipboard, which it uses for copying and pasting clips. DVP does not copy clips to 
or paste them from the Windows Clipboard. 

DVP copies and pastes palettes using the Windows Clipboard.



codec
Compressor/decompressor. The compression portion codecs are used to compress and decompress video files.



compression
The process of compacting video data so that it will require less space on a hard disk. Video compression methods 
are lossy in nature--greater compression comes at the expense of quality.



cross-fade
The transition between two overlapping audio segments in which the first one fades out as the second fades in.



data rate
A way of referring to the amount of digital information that a video file contains. The data rate depends on several 
factors: the number of frames per second (fps) in the video; the frame size; the video and audio formats; and the type 
of compression used. An uncompressed video with a high frame rate, relatively large frame size, and rich video and 
audio formats requires hardware capable of sustaining a high data rate to play back with acceptable quality. The 
appropriate data rate for a video depends on the capabilities of the delivery medium. In particular, CD-ROM drives 
support much lower data rates than disk drives do.



delete (segment)
When you delete a segment from the timeline, the following portion of the clip moves over to occupy the position of 
the segment you deleted. (In comparison, when you erase a segment, the following portion of the clip does not move, 
and instead a gap appears in the clip.) You can control whether DVP deletes or erases segments by choosing 
Options from the Tools menu.



device driver
A program that allows Windows 3.1 to communicate with a specific piece of multimedia hardware, such as a video 
capture board. Device drivers are installed through the Windows Control Panel. See also multimedia.



device-independent
Describes an image or video that can be displayed at any resolution. 



DIB (device-independent bitmap)
A Windows and OS/2 bitmap format. Indentical to .BMP.



digital audio
Audio that is converted into a digital format by a process called digitizing and stored as a file (usually a .WAV file) on 
a hard disk, CD-ROM, or floppy disk. See also analog audio. 



digital video
Video that is converted into a digital format by a process called digitizing and stored as a file on a hard disk, CD-
ROM, or floppy disk. See also animation.



digitize
To convert analog audio and video into digital audio and video that can be manipulated on a computer.



display device
The combination of video card and video driver that determines a system's color capability. For example, an 8-bit 
video card used with the appropriate video driver can display 256 colors at a time.



dithered
Describes a color that appears onscreen as a mixture of different solid colors.



drag
In DVP, you move clips around by dragging them. You drag a clip by positioning the pointer over the clip or selected 
segment, pressing and holding down the left mouse button, and moving the mouse. As you do, the pointer arrow 
changes to a drag pointer. When the drag pointer is positioned where you want to place the clip or segment, you 
release the mouse button.



DVI
A hardware-dependent compression technique used with ActionMedia hardware.



DVP
Asymetrix Digital Video Producer.



DVP Capture
The utility that comes with Asymetrix Digital Video Producer that you use to digitize video from a source such as a 
VCR or videodisc. A capture board must be installed on your system for DVP Capture to work.



edit points
The In and Out points representing the segment of a source clip to be used in a production.



8-bit color
Describes an image or video that can contain up to 256 colors.



erase (segment)
When you erase a segment, the succeeding portion of the clip does not move, and a gap appears in the clip. (By 
comparison, when you delete a segment from the timeline, the succeeding portion of the clip moves over to occupy 
the position of the segment you deleted.) You can control whether DVP deletes or erases segments by choosing 
Options from the Tools menu.



filter
A technique used to alter the appearance of an image on a single track, such as by changing its colors or applying a 
special effect. You apply a filter to a video by selecting a video on the timeline and choosing Filter from the Effects 
menu. Filters differ from transition effects because you apply filters to a single track, while transitions are applied any 
time two video tracks overlap.



FLI/FLC
An animation file format used by Autodesk Animator (and other programs) that is supported by DVP.



font
The complete set of characters for one typeface, size, and style, such as Courier 12-point italic. 



fps (frames per second)
The number of complete images in one second of video, expressed as its frame rate. Digital video on the desktop can 
support a maximum frame rate of 15 fps without the need for a video capture board; with a video capture board, 
frame rates of up to 30 fps are possible. (A video with a frame rate below 15 fps may appear jerky when played; 
television is broadcast at 30 fps; movies run at 24 fps.) 



frame
A single image within a video file. Like a conventional video, a video file contains a sequence of frames that, when 
played back, gives the appearance of motion.



frame rate
The number of frames that occur in a video during a second of playback time, expressed in frames per second (fps). 
The higher the frame rate of a video, the better the quality.



frame size
The dimensions of a digital video image, usually expressed in pixels.



frequency
The number of samples per second in a sound or video file. The higher the frequency, the better the quality of the 
video or sound.



GIF
A compressed image format that may contain up to 256 colors. GIF format is widely used for images on commercial 
electronic bulletin board services (BBS).



high-color
A video or bitmap that is in 16-bit or 24-bit format. A high-color image or video does not require color palettes as an 8-
bit image or video does.



image
A still picture in the form of a bitmap.



in point
The point in a source clip where a segment begins. You specify an in point by using the editing controls in a Player.



Indeo
A lossy video compression standard designed by Intel.



JPEG (Joint Photographic Experts Group)
A lossy compression standard used for 24-bit color and 8-bit grayscale bitmaps.



key
To add a background color to an overlay, which is then made transparent so that the underlying video shows through. 
Keying is used, for example, to create titles on an overlay; the key color becomes transparent, allowing the video to 
appear behind the titles.



key color
In the process of keying, the background color used for transparency in the foreground image. The key color 
becomes transparent when the video is built, allowing areas on underlying video tracks to show through, such as 
when you add a title overlay.



key frame
A complete video frame that contains all information about the image in the video. (By comparison, nonkey frames 
typically contain only data about areas of the frame that have changed compared to the previous frame.)



keying
The process of displaying a background image through certain colors of a foreground image, such as the image of a 
meteorologist in the foreground superimposed on a weather map. The meteorologist is actually in front of a single-
color background panel, the color of which is then keyed to be transparent.



Kodak Photo CD
A compact disc that contains photos. To use Photo CD images, your CD-ROM drive must be capable of playing Photo 
CDs.



lossless
Refers to a compression method that does not remove information from the video or image being compressed. The 
image quality is not affected by lossless compression methods, but file size reduction may not be as great as that 
achieved by lossy methods. Microsoft RLE is a lossless compression method. 



lossy
Refers to a compression method that permanently removes information from the video or image being compressed. 
Although the image quality is decreased, the results may be imperceptible to your audience, and the file size may be 
greatly reduced. Cinepak and Intel Indeo are examples of lossy compression methods. See also lossless.



marking
The process of defining edit points on a source clip.



MCI (Media Control Interface)
A Windows standard set of commands that can be used to control media devices. Used for communication with 
external devices such as VCRs and videodisc players. 



media device
Hardware that controls a source of multimedia. For example, a CD-ROM drive can play CD audio, and a sound board 
can play MIDI and wave audio. 



media device channel
A hardware device used to play a sound. Only one sound of a specified media type can play at a time through the 
channel, because only one sound at a time can access the necessary hardware. If you have a sound card with a 
MIDI port, you can play a MIDI and a wave audio file simultaneously, but you cannot play two MIDI files or two wave 
audio files simultaneously. 



media file
Any wave audio, MIDI, animation, bitmap, or digital video file that can be used within Asymetrix Digital Video 
Producer. 



media source
Any media--including files, CD audio, videodiscs, videotape, or embedded wave audio or MIDI resources--from which 
you can create clips.



MIDI
Musical Instrument Digital Interface. MIDI devices are the standard way to connect synthesizers, keyboards, and 
other musical instruments to computers to create synthesized sound. MIDI is not actual sound, but a series of 
commands sent to the synthesizer. You must have a Media Control Interface (MCI)-compatible sound card installed to 
play MIDI files.



MPEG (Motion Picture Experts Group)
A video compression standard that does not require, but benefits greatly from, built-in support provided by some 
video capture board manufacturers. MPEG is also used for compressing interactive television video. Refer to your 
video capture board documentation to determine if it supports this standard.



multimedia
Any combination of sound, graphics, digital video, animation, and analog video played on a computer. 



nonlinear editing
Editing video using many video clips that can be manipulated and arranged independently and in combination, as in 
DVP.



NTSC (National Television Standards Committee)
Acronym for a video standard used in the U.S., Canada, Mexico, Japan, and Central and Latin America. The NTSC 
standard has a vertical resolution of 525 lines and 30 frames per second.



optimize
To create an 8-bit color palette based on the most frequently used colors in a range of video frames. You can optimize 
a palette as you convert 24-bit or 16-bit video to 8-bit video to prevent palette shifts when the 8-bit video is 
subsequently played back.



optimization
A procedure that determines the most frequently used colors in a range of video frames and creates the best possible 
256-color palette for a particular image or video clip, which you can then apply.



out point
The point in a source clip where a segment ends.



overlay
An image, digital video, analog video, or title that appears in front of the other images in your video. In DVP, overlay 
clips appear on the Overlay track. See also digital video, videodisc.



PAL (Phase Alternation by Line)
A video standard used in Western Europe (except France), Africa, the Middle East, and Brazil. The PAL standard has 
a vertical resolution of 625 lines and 25 frames per second.



palette
A predefined set of colors that is stored with a 256-color bitmap or video, or that you store in a palette file 
(extension .PAL). Palettes are for use with 256-color display devices; most often, you use them to create a common 
set of colors throughout a video and avoid palette shifts. You can create, save, load, and apply palettes to videos that 
you create in DVP. 



palette shift
A brief flashing that occurs as you switch from one image to another (for example, by opening an image file, or 
playing a video clip) while using an 8-bit video display system. Windows switches color palettes so that the new 
image displays on your screen correctly. As it does, a brief flashing may occur, and the images and other portions of 
your screen may momentarily appear with the wrong colors. Although Windows quickly adjusts the screen to the new 
palette, the palette shift can be distracting to a viewer.



PCX
A Windows-compatible bitmap format used by many bitmap editing programs that may contain 1, 4, 8, or 24 bits. Also 
called Paintbrush format.



pixel
Short for picture element. A dot of color in a video or still image. Combined, pixels of varying colors or shades create 
an image.



play
To activate a clip. You play a clip by dragging it into a Player window and clicking the play forward button (unless Play 
Clip Automatically is checked in the Player Options dialog box).



project
A collection of source clips and effects arranged on the timeline and used by DVP to build new videos.



QuickTime
A video file format originally used on Apple Macintosh computers and now available under Windows. To use a 
QuickTime movie with DVP, you must first convert it to .AVI format.



RLE (Run-Length Encoding)
A type of 8-bit compression typically used with animation files and some bitmaps. It best provides compression for 
media that have relatively uniform color. 



sample
The process of digitizing analog audio and video into computer information. Also called capturing.



scale
Frame sequence, expressed either as absolute frame numbers or in timecode.



scanning
The process of creating a digital version of a graphic that you can manipulate on your computer. 



SECAM
Acronym for a video standard (Séquentiel Couleur Avec Mémoire) used in France, Eastern Europe, Russia, and parts 
of Africa. The SECAM standard has a vertical resolution of 625 lines and 25 frames per second.



segment
In DVP, a series of sequential frames extracted from one media clip.



smoothing
When overlaying graphics or text, a method of blending the edges around the keyed areas. Also called anti-aliasing.



sound
A CD audio, MIDI, or wave audio clip that can be played in a DVP application. 



TGA (Targa)
A bitmap format developed by Truevision. TGA is a standard format, but not as widely used as .BMP, .PCX, or .TIF 
formats. TGA files may be saved as uncompressed or compressed (run-length encoded).



thumbnail
A small image representing a video or other media clip, displayed as a placeholder on the DVP timeline, in the Media 
Window, or in a preview window (when a video is stopped).



TIF (or TIFF, Tagged Image File Format)
A platform-independent bitmap format standard created by Aldus. TIFF is used widely, but many variations of it exist, 
including different versions that may use any of six different compression methods (no-compression, Huffman, Pack 
Bits, LZW, Fax Group 3, and Fax Group 4).



timecode
A method of representing time. HH:MM:SS:FF displays hours, minutes, seconds, and frames, respectively. Timecode 
(as opposed to frame number) is available with professional video decks; you use timecode with DVP Capture to 
capture one or more specific sequences from a source video, based on their exact chronological positions in the 
source video. 



title
Text that is added to a video, like credits that appear in a video. In DVP, you can add titles to videos and control how 
they move, rotate, and zoom.



track
An area of the DVP window where you drag and drop a clip. You arrange clips (video, image, sound, transition, and 
overlay) on tracks to create your video. 



transition effect
A special effect, such as a wipe, that creates a smooth shift from the end of one video clip to the beginning of another. 



VCR
Video Casette Recorder.



video
A series of images that occur over time, and that may contain sound. In DVP, you create your video by combining 
other videos, bitmaps, and sound.



video capture
The process of digitizing audio and video into computer information. You can use DVP Capture to capture video files 
from a source such as a VCR, video camera, or videodisc, and then save the captured video as an .AVI file. Also 
called sampling.



video capture board
A specialized piece of hardware that allows your computer to digitize video from a source such as a VCR, a video 
camera, or a videodisc.



Video for Windows
A file format and specification for storing video and audio in Windows. The file format used is Audio/Video Interleaved 
(.AVI), a format that automatically synchronizes audio and video information. 



videodisc
A read-only optical disc used to store analog video images and associated audio information, which you can use in a 
DVP video. See also multimedia.



VISCA
A protocol developed by Sony Corporation for controlling VCR machines from the computer, for precise and easy 
capture and editing.



visual media clip
A clip created from an animation, digital video, analog video, Photo CD image, or bitmap. 



voiceover
Sound, such as narration, that you add to a video during the production process rather than while recording the video.



WAV (wave audio)
A digital audio format for sound that is stored as a file on a hard disk, CD-ROM, or floppy disk. 



waveform
A representation of sound in which the volume of an individual sample is displayed, showing the peaks and lulls in 
volume over time.



zoom
To increase or decrease the size of a title or overlay. In DVP, you create zoom effects using the Path dialog box. 



Map pop-ups



Open Project button
Opens an existing DVP project file. Only one project file can be open at a time.

Clicking this button is the same as choosing Open Projectfrom the File menu.



Import Media button
Imports any media files (.AVI, .BMP, .DIB, .FLI, .FLC, .GIF, .PCX, .TGA, .TIF, or .WAV) that you want to include in 
your project. 

Choosing this command is the same as choosing the Import Media command on the File menu.



Build button
Displays options for the output video. When you choose options and click OK, DVP builds the video; if you need to 
specify compression, filter, or other options, do so before specifying build options.

Clicking this button is the same as choosing Build from the Video menu.



Play Last Built button
Plays the most recent output video. This command is available only if you have built a video since you started the 
current session of DVP.

Clicking this button is the same as choosing Play Last Built from the Video menu.



Cut button
Removes the selected media file or effect from the timeline and temporarily places it on the DVP internal clipboard. 

Clicking this button is the same as choosing Cut from the Edit menu.



Copy button
Copies the selected media file or effect from the Media Window or the timeline and temporarily places it on the DVP 
internal clipboard. 

Clicking this button is the same as choosing Copy from the Edit menu.



Paste button
Places a copy of a media file or effect onto the timeline. 

Clicking this button is the same as choosing Paste from the Edit menu.



Zoom In button
Magnifies the timeline to display it in smaller increments. 

Clicking this button is the same as choosing Zoom In from the View menu.



Zoom Out button
Reduces the view of the timeline to display it in larger increments. 

Clicking this button is the same as choosing Zoom Outfrom the View menu.



View Range button
Displays the starting point and the number of frames to display on the timeline. You can view the current range, or 
choose a new view range.

Clicking this button is the same choosing Set Rangefrom the View menu.



Display All Tracks button
When this command is selected, DVP displays all six tracks (Video A, Video B, Trans., Overlay, Audio A, and Audio B) 
of the timeline simultaneously. You can then see how the media files are arranged relative to one another as you 
work.

Clicking this button is the same choosing Display All Tracks from the View menu.



Point & Click button
A button on the DVP tool bar that you use to get information about features in the DVP window. Click the Point & Click 
button and then click an area of the DVP window to get information about the area of interest.



Trans. track
The track on the timeline where transitions are located.



Overlay track
The track on the timeline used for overlay images, videos, or titles.



Cut and Paste indicators
Indicates the current setting for the Cut/Paste option in the Options dialog box.



Media Window
The location where media files that are part of the project are stored. When you import a media file, DVP adds the file 
to the Media Window. Media files must be added to the timeline to appear in your output video.



Tool bar
The place where buttons for commonly-used DVP tools are located. Click the Point & Click button at the bottom of the 
tool bar, then click the button about which you want information.



Tick bar
The area just above the timeline that displays the current view range in frame numbers.



timeline
Six tracks used for constructing new videos. You drag clips from the Media Window or drag segments from the Player 
windows onto a timeline track. You can then arrange the clips on the timeline in the way you want them to play in your 
video. 



Video track
Either of two tracks on which videos are located.



Audio track
Either of two tracks on which audio clips are located.



Title bar
The area at the top of the DVP window that indicates the name of the project file that is currently open.



Menu bar
Located below the title bar, along the top of the DVP window. The menu bar contains all DVP commands.

To view the contents of a menu, do one of the following:

Within DVP, click the menu name with the mouse.
Within DVP, press Alt+n, the underlined letter in the menu name.



Player preview window
The area in the Player where you view and edit video and animation files. 



Clip indicator
Highlights the segment of the clip that you have marked.



Player
The area in the DVP window that you use for viewing and editing video files. If the clip is audio-only, the window 
remains dark as the audio plays.



Exit button
Clears the Player, and restores it to its original size. (You can drag a new clip into the Player without clicking Exit. The 
older clip clears automatically.)



Video button
To view a clip without sound, click the Video button. 



Audio button
To play the sound in a clip without viewing the video, click the Audio button. 



Video and Audio button
To play both video and audio, click the Video and Audio button.



Step Back button
Moves the clip one frame backward.



Step Forward button
Moves the clip one frame forward.



Jump To Start button
Moves the clip to the first frame.



Jump To End button
Moves the clip to the last frame.



Jump Back button
Moves the clip back approximately 10 percent of its length.



Jump Forward button
Moves the clip forward approximately 10 percent of its length.



Play Reverse button
Plays the clip backward at normal speed.



Play Forward button
Plays the clip forward at normal speed.



Pause button
Stops the clip at the current frame.



Frame Select knob
Drags the clip to a specific frame.



Edit Point indicator
Shows the current location of the Mark In and Mark Out points.



Mark In button
When clicked, marks the current frame as the beginning of the segment. The frame number is indicated in the display 
to the left of the button.



Mark Out button
When clicked, marks the current frame as the end of the segment. The frame number is indicated in the display to the 
left of the button.



Frame Counter
Indicates the current frame number and total number of frames in the clip.



Key frame indicator
A "K" indicates that the current frame is a key frame.



Asymetrix Digital Video Producer Quick Start
This section provides an overview of how to create a video using Asymetrix Digital Video Producer (DVP).

Although projects differ, creating a video typically follows this sequence:

1. Selecting media files and adding them to the project 

2. Previewing and marking a clip

3. Positioning media on the timeline

4. Adding special effects

5. Adjusting color palettes

6. Previewing the video

7. Building the video

8. Saving your project



1. Selecting media files and adding them to the project
Overview

After starting DVP, you begin a project by locating and importing media files. These files may be video, audio, or 
bitmap files, which can be in a number of file formats. 

You can import video from two types of sources. You can import existing files from your hard disk or CD-ROM, or 
you can use DVP Capture to capture video from a source such as a VCR or videodisc, then import the captured 
video into your project.

You import media using the Import Media command on the File menu. When you import a media file, DVP adds 
the file to the Media Window, where it displays the media files that you'll use in your project. Although a file in the 
Media Window is associated with your project, it doesn't become part of your video until you drag it onto the 
timeline.



Step-by-step
Adding a clip to the timeline 
Importing a media clip
Starting a new project 



2. Previewing and marking a clip
Overview

You can preview a clip and mark the section that you want to use in your video. You do this by dragging a clip from 
the Media Window into either of the two Players. You can then preview the clip (whether it's a video, animation, 
bitmap, or audio file) and mark the beginning and ending points of the segment you want to use in your video.



Step-by-step
Adding a clip to the timeline
Marking a clip segment
Playing a clip



3. Positioning media on the timeline
Overview

After you've used the Player to mark the segment of a media file that you want to use in your video, you're ready to 
add the marked segment to the timeline. Do this by dragging the segment from the Player to the timeline. Once a 
clip is on the timeline, you can move it, delete it, and preview it. You can also add transitions and other effects; 
titles and other overlays; and other video, audio, and bitmap media.



Step-by-step
Adding a clip to the timeline
Marking a clip segment 
Modifying a transition effect
Moving a clip on the timeline
Previewing a video 



4. Adding special effects
Overview

Once a media clip is on the timeline, you can modify it in a number of ways. You can apply one or more filters to a 
single video track to create simple video effects such as fade-ins and fade-outs, or more specialized effects such 
as color inversion or ripples.

You can also control how media on each of the two audio and video tracks interact in the video by modifying the 
transition between them. For audio tracks, you can choose whether or not to cross-fade as one track ends and the 
next begins. For video, you can choose from a list of transition effects (many of which you can customize) to 
control how one video clip ends as the next begins.

Finally, you can easily add titles and other overlay tracks, and specify key colors. You can also control how titles or 
other overlays move, zoom, or rotate in the video. 



Step-by-step
Adding a clip to the timeline 
Adding and editing titles 
Modifying a transition effect
Removing a transition effect 



5. Adjusting color palettes
Overview

Getting acceptable color quality can be a challenge when you're working with 8-bit videos, which are commonly 
used in desktop presentations. If an 8-bit video file uses several different color palettes, the video goes through 
palette shifts when the video plays.

DVP can help you avoid these palette shifts and create smooth, professional videos. You can create a palette that 
is optimized for the colors in your video; you can include the colors in the presentation in which your video will be 
played as part of this palette. You can then apply this optimized palette to your video, and save it for use with other 
videos. 

Note: Although you typically create and apply palettes after importing and arranging media clips on the timeline, 
it's a good idea to plan for color before you start creating a video. In general, if your final video will be played back 
on an 8-bit monitor, you should limit color changes within the video if possible, particularly if your video contains 
color video segments (as opposed to black-and-white videos or simpler animations, for example).



Step-by-step
Copying a palette
Loading a palette
Optimizing a palette
Saving a palette



6. Previewing the video
Overview

As you create your video, you'll want to check your progress frequently. You can do this in DVP without actually 
building a version of your video (which can be time consuming), but by previewing the contents of the timeline, 
including transitions, filters, titles, keying, audio, and palettes that you've applied. 

Note: Previewing the contents of the timeline is different than previewing a single media file. You preview the 
contents of the timeline in the preview window. Because DVP must play each media clip and effect simultaneously, 
playback is slower than it is in the final video. In contrast, you preview (and mark) single video clips in a Player, 
where you can step through them frame by frame or play them in real time. 



Step-by-step
Building a video 
Previewing a video



7. Building the video
Overview

When your video is arranged the way you want it on the DVP timeline, the challenge is to build an output video 
that meets both your technical and aesthetic requirements. At this stage, you'll need to decide how to handle the 
tradeoff between quality and economy. In general, the higher the quality of a video, the more expensive the 
hardware you need to play it properly. More particularly, you'll face questions such as:

How many colors: 8-bit, or better? 
What size and visual quality are required?
How good must the audio sound? Does it only include a voice, or does it include music that requires higher 

quality reproduction?
How much information will the playback equipment be able to handle? In particular, will the video be played 

back from a CD-ROM (which is slower than a hard disk, and therefore can't handle as much information)?
What are the file size limitations for your video?

Decisions about these and other questions come into play when you build a video. You control the quality and 
economy of your video by specifying the frame size of the video, the format of the video, the quality of the audio, 
the type of compression, data rate, key frames, bit depth, and other important factors. 

Note: In addition to video format, you can build your video in other formats--as a series of bitmaps, if you want, or 
simply as an audio file. 



Step-by-step
Building a video

Menu commands
Compression 
Build 
Output Format 

Reference topics
Color palettes 
Compression tips
Frame rate 
Frame size 
Sound characteristics 
Tips for using sound 



8. Saving your project
Overview

It's a good idea to save your project file often throughout the process of creating your video, as you do for any 
important work. Not only do you avoid losing work in the event that a system failure or other problem occurs, but 
you can use the current project as the basis for creating different versions of your video in the future.



Step-by-step
Saving a project



Reference topics
Color palettes
Filters (descriptions)
Frame rate
Frame size
Media file formats
Sound characteristics
Tips for using sound
Transitions (descriptions)
Compression tips



Color palettes
Reference topics

If you create a video in DVP to play back on an 8-bit display system (such as a standard SVGA video system), 
you'll get the best color results if you learn how to work with palettes. When you work in DVP, you generally use 
color palettes for two reasons:

To reduce the thousands or millions of colors in your project's images and video clips to the 256 colors 
available for playing back the output video at the best quality possible. 

To prevent palette shifts when you use your video in a presentation, which has its own palette.
Only 8-bit formats use palettes. These include bitmaps, animations, and videos created with RLE compression or 
Microsoft Video 1 compression. If you are creating a high-color video, you may not need to be concerned about 
color palettes.

Creating and applying palettes is particularly important (and challenging) for video; one segment in a video may 
look best using one palette, while another segment requires a completely different palette. Although you can apply 
different palettes to different portions of a video, the resulting palette shifts during playback are distracting and 
generally not acceptable for professional-quality productions. The best solution is usually to optimize one palette 
for each video, even though this may mean compromising the overall quality of 8-bit color reproduction. More 
commonly, if you combine two or more video sources in DVP, DVP can create an optimized palette that all the 
combined media sources can use.

Most images have a palette stored with them, which generally contains the 236 most common colors in that 
particular image. (Although 8-bit video can display up to 256 colors, Windows reserves 20 of these colors for its 
own use.) When you display an image that contains more than 236 colors, Windows uses the palette to determine 
which 236 colors it should display. If the palette is optimized correctly, the image displays at the best quality 
possible, given the limits of your system.

Note: If you're creating video sequences for 8-bit systems, you should use an 8-bit video format. If you play 16- or 
24-bit videos on an 8-bit system, the video is automatically mapped to a palette and displayed. However, high-
color video sequences use dithering to display color information properly on an 8-bit display adapter. Dithering 
slows color display and lowers the quality of color reproduction.

When you work in DVP, the program uses its own palette to prevent palette switching; all thumbnail images are 
mapped to this palette. Everything in the Media Window, on the timeline, or in a video that is paused in a Player is 
displayed using the DVP palette. When you play a video clip in a Player, DVP switches to that video's palette. 
When playback is complete or paused, DVP switches back to its own palette. (If you want to avoid switching 
palettes, check Play Video Using DVP Palette in the Player Options dialog box, which maps video playback to the 
DVP palette.) 

The DVP palette is stored in the DVP.PAL file. If you delete this file, DVP uses a grayscale palette in its place.



Step-by-step
Loading a palette 
Optimizing a palette
Saving a palette 

Menu commands
Create Optimal Palette 



Filters (descriptions)
Reference topics

DVP comes with several filters, which you can apply to a video track one at a time or in combination.

Filter Description Options

Fade to Black Current video fades to black. Out To Black 
In From Black

Fade to White Current video fades to white. Out To White
In From White

Black and White Current video loses color. None

Invert Red, green, or blue channels 
invert to their opposite color.

Red Channel
Green Channel
Blue Channel

Ripples Current video warps like ripples 
in water.

Number of Waves
Wavelength

Color Balance Red, green, and blue values of 
current video are adjusted.

Red
Green
Blue

Brightness and 
Contrast

Brightness and contrast of 
current video are adjusted.

Brightness, Contrast

Tile Current video is replicated in 
multiple tiles.

Vertically n Times
Horizontally n Times

Blur Current video is blurred. Amount of blur

Sharpen Current video is sharpened, 
enhancing details.

Amount of sharpening

Emboss Current video is given a 
sculpted appearance.

None

Chalk Drawing Current video is outlined, as if 
drawn on a blackboard.

None



Menu commands
Filters



Frame rate
Reference topics

The value for frame rate specifies the number of frames per second for your new video. AVI files typically play 15 
to 18 frames per second (fps), which provides a realistic sense of motion. Higher frame rates of up to 30 fps (the 
frame rate of television in the U.S.) provide smoother motion, but also result in much larger video files and require 
a video board to run smoothly. Frame rates lower than 15 fps result in smaller video files but can be rough or jerky 
when played back.

It's particularly important to consider frame rate in your DVP video when you use clips from files that have different 
frame rates. The default option for frame rate in the Output Format dialog box (Maintain Frame Numbers) specifies 
that video be inserted on a frame-by-frame basis. 

For example, if one video clip is 20 fps, but you are inserting 5 seconds from a 10 fps video clip, all 50 video 
frames of the second clip will be inserted into the new video. At the new frame rate of 20 fps, the 50 frames result 
in only 2.5 seconds of video. However, since audio is time-dependent, you will have inserted a full 5 seconds of 
audio into the new video. Therefore audio and video from the source clip will no longer be synchronized.

To maintain video/audio synchronization while mixing frame rates, select Synchronize Video in the Output Format 
dialog box. This option causes video frames to be dropped or added as needed to maintain the full 5 seconds of 
video at the new frame rate. This option can also be used to create slow-motion and fast-motion effects.

To prevent dropping or adding frames when you are editing files that have similar frame rates, select Maintain 
Frame Numbers.



Step-by-step
Building a video 

Menu commands
Output Format



Frame size
Reference topics

The size of your video onscreen is expressed in X and Y pixel values. The X value is the horizontal dimension, and 
the Y value is the vertical dimension. In DVP, you select the frame size in the Output Format dialog box.

Many .AVI files have a frame size of 160 pixels by 120 pixels. Although larger frame sizes may look better, they 
also require more disk space and a faster machine on which to play back. For example, a 320-pixel-by-240-pixel 
video requires four times the disk space, and may play back with jerky motion, compared to the same video at 160 
pixels by 120 pixels. Selecting a frame size, then, depends on the amount of space available for storage and the 
capabilities of the systems used to play it back. 



Step-by-step
Building a video 

Menu commands
Output Format



Media file formats
Reference topics

A large number of media types currently exist for storing images, audio, and video. Each of these types also has a 
number of attributes, such as compression, data rate, and frame size. Although DVP handles the combinations of 
attributes, occasionally you may need to adjust some formats.

Tip: To view the format information about a media clip, double-click the thumbnail image in the Media Window, or 
select the clip and choose Media Statistics from the File menu.

The default format in DVP is the Audio/Video Interleaved (.AVI) format. .AVI allows both video and audio to be 
stored together for synchronous playback. 

The format DVP uses for audio-only files is the wave audio (.WAV) format. Use this format to store music and 
narration that do not require accompanying motion video.

The formats DVP uses for animation files are .FLI and .FLC formats. These formats do not include audio 
information. Also, the format is not synchronous; unlike .AVI files, which, if played on a slower machine, skip video 
frames as necessary to keep in time, .FLI and .FLC files slow down in order to display every frame.

Still image information can be stored in a variety of bitmap formats: .BMP, .DIB, .GIF, .PCX, .TIF, and .TGA.



Step-by-step
Importing a media clip 

Menu commands
Import Media 
Output Format



Sound characteristics
Reference topics

An integral part of every video is the soundtrack. Understanding how to use audio in DVP requires a grasp of a few 
key ideas. 

Channels    Mono plays the same audio through both channels, while stereo has two separate channels. 
Typically on the computer, stereo is only used for high-fidelity music applications or sound effects.

Sample size    The amount of data in each sample of audio. Most desktop applications use 8-bit sampling; 
16-bit sampling is equivalent to CD-quality sound.

Sample rate    The number of audio samples per second, expressed in kilohertz (kHz). The higher the 
sample rate, the better the sound quality (and the more space required). DVP works with audio files sampled at 
11.025kHz, 22.05kHz, and 44.1kHz. 

Higher quality audio is not always the best choice. For example, an audio track that is 44.1kHz, 16-bit stereo 
requires sixteen times the space of the same audio sample at 11.025kHz 8-bit mono. Because the amount of data 
in an audio stream can drastically reduce the playback performance of the video, you should always use the 
lowest acceptable quality for audio. 



Menu commands
Audio Cross-Fade 
Audio Level 

Reference topics
Tips for using sound



Tips for using sound
Reference topics

Selecting what your audience will hear, and how they hear it, is critical to the quality of your videos. If you record 
your own sound, always make sure your audio track is loud enough by positioning your microphone as close as 
possible to the sound source. You might find that an external microphone with a long cord helps you get 
professional quality sound. When recording a soundtrack for editing, keep in mind that the quality of audio 
recording on a hi-fi camcorder is probably better than any nonprofessional recording equipment you may own.

Narration    If the video is not self-explanatory, a voiceover can be an important tool for clarification. When 
using narration, remember to fade down music or any other sound during narration segments. With DVP, you can 
easily add narration by dropping it on the unused audio track. If necessary, you can fade the other audio track to 
accommodate the narration.

Music    Select music based on the mood, tempo, and energy you want to convey. You can add music from 
any audio source (provided that you have secured copyright permission as necessary), including libraries of stock 
music on CD-ROM. 

Remember to fade music in and out to avoid any abrupt blast of sound. If you need to add both narration 
and music to an original soundtrack, add the narration first, then build the video. Afterwards, load the new video, 
place it on the Video A and Audio A tracks, and then add music to the Audio B track.

Rhythm    Videos look most professional when a video cuts from one scene to another with the rhythm of the 
sound. Make your cut when the tempo of the music changes, or when the narrator pauses. In DVP, you can use the 
waveform graphs on the audio tracks to locate these changes and pauses.

Transparent editing    Audio from one scene can lead into the next, producing a smoother transition. 
Creating this type of smooth transition is called transparent editing. For example, from one scene you can continue 
the audio track of a conversation for a couple of seconds into the next scene, so the audience sees the beginning of 
the second scene while hearing the end of the conversation. 



Menu commands
Audio Cross-Fade 
Audio Level 

Reference topics
Sound characteristics 



Transitions (descriptions)
Reference topics

When two video tracks overlap, DVP automatically adds the default transition, a wipe. You can modify the 
transition by applying one of the transitions below. 

Transition Description Options

Wipe New video gradually covers 
old video.

Wipe Direction

Dissolve Old video fades into new video. None

Iris Old video opens up into new 
video.

Iris Shape

Clock New video covers old video in 
circular motion.

None

Slide In New video slides onscreen, 
covering old video.

Slide In Direction

Slide Out Old video slides offscreen, 
revealing new video.

Slide Out Direction

Band Slide In Bands of new video slide into 
view, covering old video.

Vertical or Horizontal
Number of Bands

Band Slide Out Old video splits into bands and 
slides off, revealing new video.

Vertical or Horizontal
Number of Bands

Barn Doors Old video splits to reveal new 
video.

Orientation
Doors Slide

Blinds New video wipes over old video 
in several bands.

Vertical or Horizontal
Number of Blinds

Push New video pushes old video 
offscreen.

Push Direction 

Blocks Blocks of new video appear, 
covering old video.

Grid
Remove Blocks

Fizzle Old video "fizzles" pixel by pixel 
into new video.

None

Blizzard Old video "blows away, revealing 
new video.

None
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Compression tips
Reference topics

Video compression modifies a video file to decrease its size. 

Video sequences are compressed and decompressed by special routines called codecs. You use the compressor 
portion of a codec when you create a video; when you play back the video, the codec decompresses the video so 
it can be displayed on your computer system.

You can choose from among several types of compression when you create a video in DVP. The one you choose 
depends on the quality you need (meaning both the appearance of the video and how smoothly it plays); file size 
limitations; and the time required for compression and playback. You may need to experiment to determine which 
compression method works best for your video. 

Avoid applying multiple compression methods to a video sequence. Most methods result in some loss of quality, 
and the loss is compounded if multiple techniques are applied. When experimenting with compression settings, 
save the original uncompressed version of your video sequence.

If you own a video capture board, you may have received other compressor drivers than the codecs that come 
with DVP. For details, refer to your video capture board's documentation.

DVP includes these codecs:

Microsoft Video 1    Combines good playback quality with relatively quick compression time. If you use the 
8-bit format, you can specify which palette to use in the video sequence, providing better control over the palette 
colors than compression methods using an automatic dithering technique. This method does not support 24-bit color.

Cinepak Codec by SuperMatch    Provides excellent compression for video sequences delivered on CD-
ROM. Cinepak provides good image and motion quality at CD-ROM data-transfer rates. The video sequence is 
stored using the 24-bit color format, which preserves much of the original video's color information. When playing on 
8-bit displays, Cinepak uses dithering to transfer the 24-bit color values to an 8-bit palette format. Cinepak uses an 
asymmetric compression technique, one that takes much longer during compression than during playback.

Intel Indeo Video R3.2    Provides high-quality video for delivery on CD-ROM and other systems. Indeo 
uses an asymmetric compression technique and stores the video in a 24-bit color format. When played on 8-bit video 
display devices, the codec dithers the 24-bit color to an 8-bit format. Intel recommends using a key-frame interval of 
4.

Intel Indeo Video Raw    Creates smaller video files by separating the color information differently rather 
than by compressing the file. Available on any video capture board that uses the I750 compressor chip, such as the 
Intel Smart Video Recorder or Creative Labs Video Blaster RT300. Offers you a viable way to reduce file sizes during 
video capture and then apply more significant compression later in your video production process.

Microsoft RLE    Provides compression best used for computer-generated animation, bitmaps, and media 
that have relatively uniform color. The quality suffers and file size increases with more complex video scenes, such as 
live video that you're capturing directly from a video camera. You can use this method only when producing 8-bit 
video sequences.

Full Frames (uncompressed)    Saves each frame in the video as an uncompressed bitmap. If the 
sequence was already compressed, the bitmaps will show any distortions introduced during compression. While it 
can save some time to do rough-cut editing in this format, only compressing after the final cut, DVP's drivers minimize 
recompression.
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Importing a media clip
Step-by-step

Importing media clips into a project is the first step in editing a video. DVP imports only information about the 
location of the file on your hard disk or CD-ROM; the file itself is not moved, copied, or altered. 

To import a media clip:
1. Click the Import Media button on the tool bar. Or choose Import Media from the File menu.
2. In the Import Media dialog box, select one or more media files you want to import.

Press Ctrl as you click to select more than one file.
By default, all valid file types are in the dialog box. To list only files of one type, select a file type from List Files 
Of Type.
If you want to preview an .AVI or .WAV file before importing it, click Preview after selecting the file, then click the 
play forward button that appears. To preview additional media files, continue to select files and click the play 
forward button.

3. Click OK.
The file or files you selected appear in the Media Window. 

Note: To import a media clip, the file extension must correspond to the driver installed on your system. File 
extensions for each installed driver are shown in the Import Media dialog box.



Saving a project
Step-by-step

When you save a project, you're saving information about the arrangement of media clips, transitions, filters, and 
titling on the timeline, as well as information about the location of the associated media files on your hard disk or 
CD-ROM. Saving a project does not create or save your video; to do that, you must build your video.

To save a project:
Choose Save Project from the File menu.

If the project has never been saved, the Save Project dialog box appears, in which you name the project. By 
default, DVP adds the file extension .PRJ.

You can save a new version of an existing project when, for example, you want to create several versions of a 
video. 

To save a new version of an existing project:
Choose Save Project As from the File menu.
The Save Project dialog box appears, in which you type a new name for the project. By default, DVP adds 

the file extension .PRJ.



Step-by-step
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Starting a new project
Step-by-step

When you start DVP, the program automatically opens a new project, into which you can import media files for 
viewing and editing. You can also start a new project after working on an existing one. However, only one project 
can be open at a time.

To start a new project:
Choose New Project from the File menu.

DVP opens a new project file and clears the timeline of all existing clips and effects. If you have not saved the 
changes you made to an existing project, DVP prompts you to save these changes before clearing the timeline. 
Media clips from the previous project remain in the Media Window of the new project. You can then import 
additional clips, or remove unneeded ones.



Step-by-step
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Menu commands
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Adding a clip to the timeline
Step-by-step

You add a clip to the timeline by dragging it either from a Player or from the Media Window. 

To add a clip to the timeline:
Drag the clip from a Player or from the Media Window to the position on the tick bar where you want it to 

begin. 
DVP adds the media file to the timeline on the appropriate track (video, audio, or overlay) at the position of 

the cursor (unless the Snap Cuts To End option is checked in the Options dialog box). For video segments that 
contain sound, DVP adds the video portion of the segment to a video track, and the sound portion to an audio track. 

If you drag a clip from a Player in which you've marked edit points, DVP adds only the marked segment to 
the timeline. Otherwise, DVP adds the entire clip to the timeline. 

You can also drag a clip directly from the Media Window to the track on which you want it to appear. If you 
add a video clip containing audio to an audio track, only the audio portion is added.



Step-by-step
Moving a clip on the timeline 



Moving a clip on the timeline
Step-by-step

You can move a clip by dragging it from one position to another on the timeline, or by cutting and pasting it. When 
you cut or copy a clip, DVP places a copy of the clip on the DVP clipboard, so you can subsequently paste it as 
many times as you want. You can also move a portion of a clip.

To move a clip by dragging:
Click the clip to select it, then drag it to a new location. DVP moves the clip to start at your new insertion 

point.
To move a clip by cutting and pasting:

1. Click the clip to select it.
2. Click the Cut button on the tool bar, or choose Cut from the Edit menu (Ctrl+X).
3. Click where you want to position the clip on the timeline.

You can move a clip to either video track, either audio track, or to the Overlay track. However, if you add a 
video clip to an audio track, only the audio track actually gets added (if the video clip has an audio track).

4. Click the Paste button on the tool bar, or choose Paste from the Edit menu (Ctrl+V).

To move a section of a clip:
1. Press Ctrl and drag along the clip to select the portion you want to move. 

Make sure the clip is not selected before you press Ctrl and drag.
2. Continue pressing Ctrl as you drag the segment to a new position on the track, or to a different track.

When you move a section of a clip, the section is either deleted or erased from the original clip, depending on 
the Cut/Paste option setting in the Options dialog box.
Note: You can select a portion of all tracks simultaneously by pressing Ctrl and dragging along the tick bar. 
Continue to press Ctrl as you move the selection to its new location.
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Copying a clip
Step-by-step

You can copy a clip from the timeline and then paste the copy back onto the timeline.

To copy a clip:
1. Click the clip to select it. Or press Ctrl and drag along the clip to select the portion you want to copy.

Note: If you want to select a portion of a clip, make sure the clip is not selected before you press Ctrl and drag.
2. Click the Copy button, or choose Copy from the Edit menu.

DVP places a copy of the clip on the DVP Clipboard. You can then Paste the clip, or paste multiple copies of it 
by Duplicating it.



Step-by-step
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Playing a clip
Step-by-step

You can preview an individual clip in your project (except .FLC and   .FLI   clips) at any time. 

To play a clip:
1. Click a clip to select it in the Media Window or on the timeline.
2. Drag the clip to a Player window.

The Player immediately plays the clip if Play Clip Automatically is checked in the Player Options dialog box. 
Otherwise, you need to click the play forward button. If you drag the clip from the Media Window, the entire clip 
plays. If you drag a clip from the timeline, only that clip plays (although the clip may be part of a longer clip in 
the Media Window).
You can pause, play, step forward, and step backward through the clip using the Player controls.

Tip: You can play the last video you built (since you started DVP) without importing it into the project. Choose Play 
Last Built from the Video menu.



Step-by-step
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Marking a clip segment
Step-by-step

You mark a segment to define the range of a clip that you want to use in your project. You can choose the 
beginning and ending frames of a clip as you preview the clip in the Player window, or you can specify the frame 
numbers of the beginning and ending frames. 

To mark a clip segment: 
1. Drag the clip to a Player window.

The clip begins playing immediately if Play Clip Automatically is checked in the Player Options dialog box. 
Otherwise, click the play forward button to preview the clip.
Note: DVP can play all types of media files except .FLC and .FLI files.

2. When the clip reaches the frame where you want the segment to begin, click the Mark In button.
This marks the current frame as the beginning of a segment. 

3. Play the clip until it reaches the frame where you want the segment to end, and click the Mark Out button.
This marks the current frame as the end of a segment. 

For fine adjustment, use the Player control buttons to step forward or step backward, and then click the Mark In 
or Mark Out button. 

Important: If you know the frame number of your beginning and ending frames, you can mark those frames 
without playing the video clip. Press the Ctrl key as you click either the Mark In or Mark Out button. Then specify 
the particular frame number and click OK. You'll find this technique particularly useful when you work with long 
video clips. 

You have now chosen a set of edit points for this clip. If you drag the clip from the Player window onto the timeline, 
only the marked segment appears on the timeline and is included in the output video. If you change your mind 
about the location of the edit points, you can simply choose new ones by repeating this procedure and clicking 
new Mark In and Mark Out locations.



Maps of screen elements
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Modifying a transition effect
Step-by-step

When you add a clip to a video track on the timeline, and it overlaps a clip on the other video track, DVP 
automatically assigns a default transition effect effect (a wipe) to the Trans. track. This makes one clip in your 
output video flow smoothly into the next. You can easily modify the transition by choosing another type of effect. In 
addition, you can specify options for many of the transition effects.

To modify a transition:
1. Double-click the transition on the Trans. track.
2. In the Transitions dialog box, select a thumbnail effect.

A description of the selected effect appears at the top of the dialog box, and the selected thumbnail 
demonstrates the transition. Scroll the display in the All Transitions box to view other transition effects.

3. Click Options to specify options for the transition effect. 
The thumbnails demonstrate only the basic transition effect, and not the options that you specify.
You can preview the transition by clicking the play forward button.

4. Click OK to close the Transitions dialog box and apply the effect.



Step-by-step
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Removing a transition effect
Step-by-step

Because a transition is necessary any time a clip in one video track overlaps a clip on the other video track, 
removing a transition effect restores the default transition effect, a wipe. 

To remove a transition effect:
1. Click the transition on the Trans. track to select it.
2. Press Delete.



Step-by-step
Modifying a transition effect



Previewing a video
Step-by-step

As you work, it's helpful to check your progress. When you preview a video, DVP plays all the visual tracks in the 
timeline simultaneously: all video, transitions, and other visual effects. Because of the complexity of mixing all 
tracks, a video preview generally runs more slowly than the final output video. 

To preview a video:
1. Click the tick bar where you want the preview to begin.
2. From the Video menu, choose Preview.

A preview window appears.
3. Click the play button in the preview window. 

The video plays one frame at a time.

You can play or pause the preview with the button in the lower left corner of the preview window. If you modify 
the clip in the timeline, the preview window immediately reflects your changes. To close the preview window, 
double-click the control-menu box in its upper-right corner. 
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Building a video
Step-by-step

Building is the final step in creating a video. Building a video can be a time-consuming task for your computer. 
Before you start the build, make sure that

all the clips are edited and arranged on the timeline as you want them.
transitions, filters, titling, and other effects are as you want them.
you've specified the format for the output video.
you've specified the compression options for the output video.
you've determined the best way to handle the color palettes in 8-bit output video.
you have enough disk space for the video.
you've previewed the video to make sure it contains what you expect.

Note: Because fragmentation of your hard disk can effect the quality of the video, you should run a utility to 
determine whether your drive is fragmented and, if necessary, defragment it before building a video. 

Once you've ensured that preparations are complete, you're ready to build the video.

To build a video:
1. Choose Build from the Video menu.
2. In the Build dialog box, select options for your video.
3. Click Build.

The Build Progress window appears, in which you can view the output video as DVP builds it. 

Note: The time DVP requires to build a video ranges from a few minutes to several hours, depending on the 
type of computer you use, the size and length of the clips, the format of your video, the type of compression, 
and the effects you applied.
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Adding and editing titles
Step-by-step

In DVP, you can quickly create titles and add them to your video. You can specify fonts and colors, and animate 
your titles (for example, moving, magnifying, or rotating them).

You add titles to the Overlay track. A project can contain only one overlay; if you need to overlay other tracks in 
addition to titles, you can build an intermediate video and reimport it to one of the video tracks.

To add and edit titles:
1. Select the section of the clip that the title will overlay.
2. Choose Titling from the Effects menu.
3. If you did not select a segment, in the Title Frames dialog box, specify the frames in which the titles should 

appear, then click OK.
The Titling dialog box appears.

4. Type your titles in the Edit Title box.
Type each title on a separate line. 

5. With a line of type selected, apply font attributes or a foreground color by clicking the buttons at the top of the 
dialog box.
Note: When you build your video, DVP displays the text on top of the video. 

6. Apply frame ranges in the Title Frames box.
7. Click Path to adjust the path (the position, movement, zoom, and rotation) of each line of text, then click OK.
8. Click OK to close the Titling dialog box.

The titles appear on the Overlay track. Unlike other clips, you cannot move or copy titles on the timeline. Instead, 
to modify an existing title track, double-click the title on the Overlay track. You can delete a title clip just as you do 
any other clip: select the clip and press Delete.

You can preview your titles by choosing Preview from the Video menu.

Tip: You can apply a different set of attributes to each line of text in your titles. For example, to display text with 
two different sets of attributes simultaneously, you apply the attributes to each line of text, and assign them the 
same frame ranges, then adjust their positions by selecting each title and clicking Path.
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Titling 



Capturing video using an MCIVCR device 
Step-by-step

With an MCIVCR-compliant video cassette recorder, you can use DVP Capture to specify exact starting and 
ending points for capturing from a videotape; you can capture up to ten video segments as a single unattended 
batch job. In addition, using an MCIVCR device can improve the quality of the capture, since you can specify that 
DVP step through the capture one frame at a time. 

To set up an MCI capture session:

1. Choose Settings from the Capture menu in DVP Capture.
The Capture Settings dialog box appears. 

2. Check Enable MCI Capture, then click MCI Settings. (This option and button are available only if an MCIVCR 
capture device is correctly installed in Windows.)
The MCI Capture dialog box appears. The MCI Driver list contains the currently-installed MCIVCR devices. 

3. From the MCI Driver list, choose the VCR device you plan to use.
4. If necessary, check the Step Capture option. 

With Step Capture checked, the MCI device steps through the video one frame at a time, allowing DVP to 
capture and store each frame sequentially. Depending on your capture hardware, you may achieve better 
image quality and compression by enabling Step Capture, because DVP will not need to drop frames. This 
option is particularly helpful when the capture is demanding, such as when you specify a large frame size, high-
quality compression, and high frame rate for the capture.
When you use Step Capture, make sure that you capture the video to disk by choosing Capture To Disk in the 
Capture Settings dialog box. Choosing this setting ensures that your MCI driver has the memory it needs to 
perform the task. However, because Step Capture can require significantly more time than normal capture, you 
should use Step Capture only if necessary. If you can achieve acceptable quality using normal motion capture, 
do so. 
If you have pre-allocated disk space (using the Allocate File Space command on the File menu in DVP 
Capture), the first file listed in the list is the pre-allocated capture file. Keep in mind that only the first video you 
capture can use this file. 

5. To add a capture file, click New.
The Add New Video dialog box appears.

6. Select or type the name for the capture file. 
7. Specify the Start and End times for the capture. 

These specifications should be in timecode (HH:MM:SS:FF); for example, 00:08:18:03. To use the current 
frame as either the start time or end time, click the cursor in the Start Time or End Time box and click the Use 
Current Frame button. 

8. Click OK to close the Add New Video dialog box. 
9. Continue to modify the capture list as desired.

To add additional video captures to the list, repeat steps 5 through 8.
To modify a capture specification you've already added, select the capture file in the list and click Edit.
To delete a capture specification, select the capture in the list and click Delete.

10. When the capture list is complete, click OK.



 

Copying a palette
Step-by-step

You can copy a palette from one portion of a media file and apply it to the entire output video. 

At any time, you can examine the list of current video palette by choosing Show Current Palettes from the Palette 
menu.

To copy a palette from an existing media file:
1. Ctrl+click to select a frame on the timeline that contains the desired palette. 
2. Choose Copy Palette from the Palette menu. 

The Copy Palette dialog box appears.
By default, From File (the palette for the frame you selected) is selected. (If you have already applied a palette 
to the project, From Movie copies the existing movie palette to the Windows Clipboard.) 
Note: If the selected file does not use palettes (that is, if it has 16 or more bits), the option is unavailable.

3. Click the Copy button. 
DVP copies the palette to the Windows Clipboard, and the Paste From Clipboard dialog box appears, allowing 
you to paste the palette into the video.

4. Click Paste to paste the palette into the video. 
DVP pastes the palette into the project, where it is applied to all frames when you build an 8-bit output video. 
The palette remains on the Windows Clipboard until you cut or copy something else. If you wish, you can open 
and paste the palette into another project.
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Optimizing a palette
Step-by-step

When you build an 8-bit video, DVP can automatically create an optimized palette and apply it to the output video. 
However, if you want to include a background palette in your video, or if you want to optimize over a certain range 
of frames, you can create a custom optimized palette as described here. 

To optimize a palette:
1. Choose Create Optimal Palette from the Palette menu.

The Optimize Palette dialog box appears.
2. Click Whole Video to create the optimized palette based on all video frames in the video, or click Section and 

select a range of frames on which to base the palette.
3. If you want to include background colors in the optimized palette for your video, click Options. Otherwise, skip 

to Step 5.
The Optimization Options dialog box appears.

4. Click Set Background, then click OK.
Note: To include background colors in the optimized palette, you must have copied the palette you want to 
include to the Windows Clipboard.

5. In the Optimize Palette dialog box, click OK.
A preview window appears as DVP creates the palette. You can stop building a palette by clicking Stop Build.
When DVP finishes creating the optimized palette, it applies the new palette to your video and places a copy on 
the Windows Clipboard.
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Loading a palette
Step-by-step

If you have saved a palette to a file, you can open the palette file and apply the palette to your video.

To load a palette:
1. Choose Open Palette from the Palette menu.

The Open Palette dialog box appears.
2. Locate and select the palette file you want to open, then click OK.

DVP places the palette on the Windows Clipboard. The Paste From Clipboard dialog box appears, confirming 
your choice to apply the palette to your video.

3. Click Paste to apply the palette to your video. Or, if you want to use the palette later as a background palette, 
click Cancel. (The palette remains on the Windows Clipboard until you cut or copy something else.)
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Saving a palette
Step-by-step

DVP lets you save a palette as a file that you can use in future editing sessions or apply to other videos. 

To save a palette:
1. If necessary, copy the palette you want to save to the Windows Clipboard.

DVP saves the palette that is on the Windows Clipboard, regardless of its source. To copy a palette from your 
current video, see Copying a palette.

2. Choose Save Palette As from the Palette menu.
The Save Palette dialog box appears.

3. Type a name for your palette and select a directory in which to save it, then click OK.
DVP saves the palette with the name you specify.
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Capturing video 
Step-by-step

You can use DVP Capture to capture video from a VCR or videodisc player and save it as an .AVI file that you 
import into DVP. The procedure below describes the basic steps for capturing a video; however, you may need to 
experiment with these steps to obtain the best quality possible on your system.

Tip: Capturing video is demanding for both your computer and its hard disk. You can prepare for the best possible 
capture by defragmenting your hard disk using any of the commercially available defragmentation programs. In 
addition, capturing video works best if you capture to an uncompressed drive (that is, a drive on which you're not 
using Stacker or DoubleSpace).

To capture video:
1. Choose Video Capture from the Tools menu in DVP.

If you start DVP Capture from within DVP, the capture video is automatically added to the Media Window. You 
can also start DVP Capture by double-clicking the DVP Capture icon in Program Manager, but you'll then need 
to import the captured video into a DVP project.
Note: You must have a video capture board installed on your system for DVP Capture to start.

2. Set the file name you will be capturing to, and allocate space for the captured file.
You set the file name by choosing Set Capture File on the File menu in DVP Capture.
You allocate space for the captured file by choosing Allocate File Space from the File menu in DVP Capture.

3. Set capture options:

Option Description

Audio Format (Options menu) Options for capturing audio. 

Video Format (Options menu) Frame size and other settings supported by your capture 
board.

Settings (Capture menu) General capture settings.

Compression (Options menu) Compression methods you can use for saving the captured 
video, as well as other options that affect the quality (and file 
size) of the video.

Video Source (Options menu) Settings for the video signal from your capture board, if your 
video capture board supports these features.

Video Display (Options menu) Settings for your capture board's video signal, if your video 
capture board supports its own VGA monitor output.

4. If your video capture board supports 8-bit video formats (many do not), you can apply an 8-bit palette to the 
captured file. 
For more information, see Palette (DVP Capture).

5. Set preview options.
You can choose from Preview Mode or Overlay Mode, if your video capture board supports video overlay.

6. Start playback on your VCR or other video device.
7. Capture the video.

You start capturing by choosing a command from the Capture menu or by clicking a button on the tool bar. You 
have four options for capturing.

Option Description

Single Frame Captures the current frame.

Frames Captures video as a series of individual bitmaps.

Video Captures motion video.

Palette Captures the palette of the current frame, which you can then save or apply to the entire 
capture file.

8. If necessary, end the capture by pressing Esc.



 

Playing back your video
Step-by-step

After building a video file, you can play it back using DVP, Media Player, or another video tool, such as VidEdit, 
that supports .AVI files. When you install DVP, the Setup program also installs Media Player and the .AVI drivers 
you need on your hard disk. 

To play a video file in DVP:
1. Start the DVP program.
2. From the File menu, choose Open Project.
3. Select the DVP file you want to play, then click OK.
4. Drag the file from the Media Window to a Player.

The clip starts playing immediately if Play Clip Automatically is checked in the Player Options dialog box. 
Otherwise, click the play forward button to play your video file.

To play a video file in Media Player:
1. Start Media Player.

If necessary, use the DVP installation disks to install Media Player first. 
2. From the File menu, choose Open.
3. Select the file you want to play, then click OK.
4. Click the Play button.
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Sending your video to someone
Step-by-step

When you distribute the video files you build in DVP, you need to make sure that your audience has the 
appropriate .AVI drivers installed on their hard disks, so they can play back the files. (Your audience does not need 
special hardware to play back DVP files, but playing them on an i486 or Pentium system ensures that your files 
perform well.) 

We included a disk called Video for Windows Runtime Setup with the DVP installation disks to make your video file 
distribution easier. This disk contains all the driver files your audience needs to view your DVP video. You can 
copy the entire contents of this disk to another disk to include with your DVP video. You may also want to include 
instructions (like the sample ones below) on how to install the files and play the video. 

To install the Video for Windows runtime files:
1. Insert Video for Windows Runtime Setup into an appropriate disk drive.
2. From the File menu in the Program Manager, choose Run.
3. In the Command Line box, type b:\setup (or specify another disk drive if necessary).
4. Click OK, then follow the installation instructions onscreen.

The necessary .AVI drivers are installed along with Media Player, which lets you use the drivers to play the 
video. 

To play a DVP video:
1. Copy the DVP video files to your hard disk.
2. Locate and run Media Player.
3. From the File menu, choose Open.
4. Select the file you want to play, then click OK.
5. Click the Play button.



Step-by-step
Playing a clip
Playing back your video



DVP window
Click the area of the Asymetrix Digital Video Producer window that you'd like to know more about.



Maps of screen elements
DVP Capture window



DVP Capture window
Click the area of the DVP Capture window that you'd like to know more about.



Maps of screen elements
DVP window



Open Project button
Opens an existing DVP project file. Only one project file can be open at a time.

Clicking this button is the same as choosing Open Project from the File menu.



Import Media button
Imports any media files (.AVI, .BMP, .DIB, .FLI, .FLC, .GIF, .PCX, .TGA, .TIF, or .WAV) that you want to include in 
your project. 

Choosing this command is the same as choosing the Import Media command on the File menu.



Build button
Displays options for the output video. When you choose options and click OK, DVP builds the video; if you need to 
specify compression, filter, or other options, do so before specifying build options.

Clicking this button is the same as choosing Build from the Video menu.



Play Last Built button
Plays the most recent output video. This command is available only if you have built a video since you started the 
current session of DVP.

Clicking this button is the same as choosing Play Last Built from the Video menu.



Cut button
Removes the selected media file or effect from the timeline and temporarily places it on the DVP internal clipboard.

Clicking this button is the same as choosing Cut from the Edit menu.



Copy button
Copies the selected media file or effect from the Media Window or the timeline and temporarily places it on the DVP 
internal clipboard. 

Clicking this button is the same as choosing Copy from the Edit menu.



Paste button
Places a copy of a media file or effect onto the timeline. 

Clicking this button is the same as choosing Paste from the Edit menu.



Zoom In button
Magnifies the timeline to display it in smaller increments. 

Clicking this button is the same as choosing Zoom In from the View menu.



Zoom Out button
Reduces the view of the timeline to display it in larger increments. 

Clicking this button is the same as choosing Zoom Out from the View menu.



View Range button
Displays the starting point and the number of frames to display on the timeline. You can view the current range, or 
choose a new view range.

Clicking this button is the same as choosing Set Range from the View menu.



Display Current Track Only button
Displays only the timeline that currently contains the cursor, so that you can work with the media file on that track 
more easily.

Clicking this button is the same as choosing Display Current Track Only from the View menu.



Display All Tracks button
Displays all six tracks (Video A, Video B, Trans., Overlay, Audio A, and Audio B) of the timeline simultaneously. You 
can then see how the media files are arranged relative to one another as you work.

Clicking this button is the same as choosing Display All Tracks from the View menu.



Point & Click button
A button on the DVP tool bar that you use to get information about features in the DVP window. Click the Point & Click 
button and then click an area of the DVP window to get information about the area of interest.



Trans. track
The track on the timeline where transitions are located.



Overlay track
The track on the timeline used to overlay images, videos, or titles.



Cut and Paste indicators
These indicators display the current setting for the Cut/Paste option (which is located in the Options dialog box).



Media Window
The location where media files that are part of the project are stored. When you import a media file, DVP adds the file 
to the Media Window. Media files must be added to the timeline to appear in your output video.



Tool bar
The place where buttons for commonly-used DVP tools are located. Click the Point & Click button at the bottom of the 
tool bar, then click the button you want information about.



Tick bar
The area just above the timeline that displays the current view range in frame numbers.



Timeline
Six tracks used for constructing new videos. You drag clips from the Media Window or drag segments from the Player 
windows onto a timeline track. You can then arrange the clips on the timeline in the way you want them to play in your 
video. 



Video track
Either of two tracks on which videos are located.



Audio track
Either of two tracks on which audio clips are located.



Title bar
The area at the top of the DVP window that indicates the name of the project file that is currently open.



Menu bar
Located below the title bar, along the top of the DVP window. The menu bar contains all DVP commands.

To view the contents of a menu, do one of the following:

Within DVP, click the menu name with the mouse.
Within DVP, press Alt+n (the underlined letter in the menu name).



Player preview window
Plays videos or images that you drag into the Player. 



Clip indicator
Highlights the segment of the clip that you have marked.



Player
The area in the DVP window that you use for viewing and editing video files. If the clip is an audio-only clip, the 
window remains dark as the audio plays.



Exit button
Clears the Player, and restores it to its original size. (You can drag a new clip into the Player without clicking Exit. The 
older clip clears automatically.)



Video button
To view a clip without sound, click the Video button. 



Audio button
To play the sound in a clip without viewing the video, click the Audio button. 



Video and Audio button
To play both video and audio, click the Video and Audio button.



Step Back button
Moves the clip one frame backward.



Step Forward button
Moves the clip one frame forward.



Jump To Start button
Moves the clip to the first frame.



Jump To End button
Moves the clip to the last frame.



Jump Back button
Moves the clip back approximately 10 percent of its length.



Jump Forward button
Moves the clip forward approximately 10 percent of its length.



Play Reverse button
Plays the clip backward at normal speed.



Play Forward button
Plays the clip forward at normal speed.



Pause button
Stops the clip at the current frame.



Frame Select knob
Drags the clip to a specific frame.



Edit Point indicator
Shows the current location of the Mark In and Mark Out points.



Mark In button
When clicked, marks the current frame as the beginning of the segment. The frame number is indicated in the display 
to the left of the button.



Mark Out button
When clicked, marks the current frame as the end of the segment. The frame number is indicated in the display to the 
left of the button.



Frame Counter
Indicates the current frame number and total number of frames in the clip.



Key frame indicator
A "K" indicates that the current frame is a key frame.



Set Capture File button
Specifies the location and name of the file in which to save the current captured video. 

Clicking this button is the same as choosing Set Capture File from the File menu in DVP Capture.



Save File button
Saves the current capture file (which you specify using the Set Capture File command) to a new file. 

Clicking this button is the same as choosing Save Captured Video As from the File menu in DVP Capture.



Preview Mode button
When selected, DVP Capture displays video frames in the preview window as they are captured. When not selected, 
DVP Capture displays single frames in the preview window. 

Clicking this button is the same as choosing Preview Mode from the Options menu in DVP Capture.



Overlay Mode button
When clicked, DVP displays the video signal as live video on your monitor, rather than digitized video. This button is 
available only if your video capture board supports its own VGA monitor output; otherwise, the button is dimmed. 

Clicking this button is the same as choosing Overlay Mode in DVP Capture.



Single Frame button
Captures the current frame and displays it. You can then save the captured frame by using the Save Single Frame 
command, or you can copy it and then paste it into another program. 

Clicking this button is the same as choosing Single Frame from the Capture menu in DVP Capture.



Frames button
Captures a series of individual frames to the capture file. 

Clicking this button is the same as choosing Frames from the Capture menu in DVP Capture.



Video button
Begins capturing the input video to the capture file, using the frame rate and other capture settings that you've 
specified. You end a capture by pressing Esc (unless you've changed this option in the Settings dialog box). 

Clicking this button is the same as choosing Video from the Capture menu in DVP Capture.



Palette button
Creates an 8-bit palette based on your captured video. 

Clicking this button is the same as choosing the Palette command from the Capture menu in DVP Capture.

Note: This command is available only if your video capture board supports 8-bit video. 



Capture Preview window
Displays video from your video source.



Menu bar
Located below the title bar, along the top of the DVP Capture window. The menu bar contains all DVP Capture 
commands.

To view the contents of a menu, do one of the following:

Within DVP Capture, click the menu name with the mouse.
Within DVP Capture, press Alt+n (the underlined letter in the menu name).



Load Palette
File menu (DVP Capture)

Displays the palette files you can select and apply to an 8-bit captured video.

Option Description

File Name Displays a list of available palette files. Select the palette file you want to open. When you 
click OK, DVP Capture opens the selected palette file.

List Files Of Type Indicates .PAL as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Set Capture File
File menu (DVP Capture)

Specifies the location and name of the file in which to save the current captured video. 

Note: The capture file is best used for temporary storage of a captured video. Its contents are replaced without 
warning each time you capture a video segment (unless you change the name of the capture file). If you intend to 
keep a captured video, use the Save Captured Video As command to save a permanent copy of the current 
capture file.

Option Description

File Name Specifies the file name under which the captured video will be saved. Type a file name of 
up to eight characters; when you click OK, the file is saved with the .AVI extension. 

List Files Of Type Indicates .AVI as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Menu commands
Save Captured Video As



Allocate File Space 
File menu (DVP Capture)

Reserves space on your hard disk for storing the capture file. Allocating space can help prevent dropped frames 
when you capture a video. 

Option Description

Free Disk Space Shows the amount of space available on the current disk drive. To change target disk 
drives, choose Set Capture File from the File menu.

Capture File Size Shows the amount of disk space (in megabytes) to set aside for the capture file. The 
capture file always uses the entire allocated space, regardless of the length or complexity 
of the video you capture, and will use more than that amount if necessary. 



Menu commands
Set Capture File (DVP Capture) 



Save Captured Video As 
File menu (DVP Capture)

Saves the current capture file (which you specify using the Set Capture File command) to a new file. Use this 
command to rename the current capture file, so you can capture successive clips without overwriting the file. 

Option Description

File Name Specifies the file name under which the capture video will be saved. Type a file name of up 
to eight characters; when you click OK, the file is saved with the .AVI extension. 

List Files Of Type Indicates .AVI as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Save Palette 
File menu (DVP Capture)

Saves the current palette from an 8-bit captured video. 

This command is available only if your capture board supports 8-bit video, and you have set it to capture video in 
8-bit format. You specify the format of a video capture by using the Video Format command.

Option Description

File Name Specifies the file name under which the current palette will be saved. Type a file name of 
up to eight characters; when you click OK, the file is saved with the .PAL extension. 

List Files Of Type Indicates .PAL as the default file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Reference topics
Color palettes 



Save Single Frame
File menu (DVP Capture)

Opens the Save Frame As dialog box, so that you can save the frame that is currently playing as a bitmap file with 
a .BMP or .DIB extension. You specify the file name, extension, and location in which to save the frame. 

The bitmap file you save has the same bit depth as the video from which it was captured. To change the captured 
video's bit depth, use the Video Format command.

Option Description

File Name Specifies the file name under which the current frame will be saved. Type a file name of up 
to eight characters; when you click OK, the file is saved with either a .BMP or .DIB 
extension. 

List Files Of Type Indicates .BMP as the default file extension. You can also specify .DIB as the file extension.

Directories Displays the current directory and path. To change to another directory, select it from the 
Directories box.

Drives Lists the available drives. To change to another drive, select it from the Drives box.



Exit 
File menu (DVP Capture)

Closes DVP Capture. If you opened DVP Capture from within Asymetrix Digital Video Producer, the display returns 
to DVP, where the captured video is placed in the Media Window.



Copy 
Edit menu (DVP Capture)

Copies the currently captured frame and its palette to the Windows Clipboard.



Paste Palette 
Edit menu (DVP Capture)

Pastes the palette that is currently on the Windows Clipboard into DVP Capture, which applies it to the next 8-bit 
video that you capture. 

Any 8-bit palette that can be copied to the Windows Clipboard can be pasted into DVP Capture. For example, you 
can paste a palette from any 8-bit bitmap: simply open a bitmap in a bitmap-editing program, copy it to the 
Clipboard, switch to DVP Capture, then paste the palette using the Paste Palette command.

This command is unavailable if your capture board does not support 8-bit video, or if the Windows Clipboard does 
not currently contain a palette.



Audio Format 
Options menu (DVP Capture)

Displays options for capturing audio. In general, you should capture audio at the lowest acceptable level of quality. 
While higher-quality audio sounds better, capturing it successfully is more demanding for your hardware and 
increases file size.

Option Description

Sample Size Sets the amount of data in each sample. Audio sampled at 16 bits sounds better, but produces 
larger files.

Channels Sets the channel, Mono or Stereo. Mono plays the same audio through both speakers, while 
stereo has two separate channels.

Frequency Number of audio samples per second, expressed in Hertz (Hz), in the audio file. The higher 
the frequency, the better the sound quality.



Reference topics
Sound characteristics



Video Format 
Options menu (DVP Capture)

Specifies the frame size and other settings for a video capture that are supported by your capture board. The 
specific settings available depend on the kind of video capture board you're using. The kinds of settings below are 
common, but refer to your video capture board documentation for more information:

Resolution, frame size, or image size
Compression tips
Bit depth
Key frames



Video Source 
Options menu (DVP Capture)

Displays settings for the video signal from your capture board. This command is available only if your video 
capture board supports these features; otherwise, the command is dimmed. The specific settings available in this 
dialog box depend on the kind of video capture board you're using; the settings below are common, but refer to 
your video capture board documentation for more information.

Option Description

Video Signal Type If your capture board supports different video signal types, displays a choice of 
Composite video, S-Video, or RGB video input. 

Video Standard Depending on the standards your board supports, displays a choice of NTSC 
(American), PAL (European), or SECAM.

Real-Time Filters Displays real-time filters such as tint, contrast, and brightness.



Video Display 
Options menu (DVP Capture)

Displays settings for your capture board's video signal and options for monitoring the video capture. This 
command is available only if your video capture board supports its own VGA monitor output; otherwise, the 
command is dimmed. The specific settings available depend on the kind of video capture board you are using. The 
settings below are common, but refer to your video capture board's documentation for more information.

Option Description

Input/Capture Toggles between monitoring the video input signal and monitoring the actual captured 
frames. 

Filters Specifies video filters for the monitor.



Compression 
Options menu (DVP Capture)

Displays software-based compression methods you can use for saving the captured video, as well as options that 
affect the quality (and file size) of the video. For the best results, use this command to compress video that you're 
capturing on an MCIVCR device. Otherwise, avoid using this command and instead use the hardware-assisted 
compression available through the Video Format command.

Using software-assisted compression during capture requires a lot of processing power, which can lead to dropped 
frames. Your video capture board handles most of the work for hardware-assisted compression, so you get better 
results.

When you use this command, the options available will vary depending on the compressors that come with your 
video capture board. You may need to experiment to determine how the options affect video capture when used 
with other DVP Capture options. For more information, refer to your video capture board documentation.

Option Description

Compressor Lists compressor/decompressor routines, called codecs, that come with DVP, or that 
come with your video capture board. 

Compression Quality Controls the tradeoff between quality and file size. Higher-quality output videos require 
larger files, and may take longer to compress.

Key Frame Specifies how often key frames are inserted in the video. In general, choosing 1 key 
frame for every 15 frames provides a good balance between quality and performance.

Configure Displays additional options for the selected compressor, if they are available. 



Preview Mode 
Options menu (DVP Capture)

When checked, DVP Capture displays video frames in the preview window as they are captured. When not 
checked, DVP Capture displays single frames in the preview window. 

Choosing this command is the same as clicking the Preview Mode button.



Overlay Mode 
Options menu (DVP Capture)

When checked, DVP Capture displays the video signal as live motion video on your monitor, rather than digitized 
video. This button is available only if your video capture board supports its own VGA monitor output; otherwise, the 
button is dimmed. 

Choosing this command is the same as clicking the Overlay Mode button.



Single Frame 
Capture menu (DVP Capture)

Captures the current frame and displays it. You can then save the captured frame by using the Save Single Frame 
command, or you can copy it and then paste it into another program. 

Choosing this command is the same as clicking the Single Frame button.



Frames 
Capture menu (DVP Capture)

Captures a series of individual frames to the capture file. 

Choosing this command is the same as clicking the Frames button. 

Option Description

Capture When clicked, adds the current frame to the capture file. 

Done Ends the capture.



Menu commands
Set Capture File



Video 
Capture menu (DVP Capture)

Begins capturing the input video to the capture file, using the frame rate and other capture settings that you've 
specified. You end a capture by pressing Esc (unless you've changed this option in the Settings dialog box). 

Choosing this command is the same as clicking the Video button. 



Palette 
Capture menu (DVP Capture)

Creates an 8-bit palette based on your capture video. When you specify the number of colors and frames and then 
click OK, DVP Capture scans the specified number of frames and creates a palette based on the colors used most 
often. It then applies this palette to all 8-bit video that you capture, until you either create another new palette, load 
a palette, or exit DVP Capture. You can save a captured palette and use it with other videos by using the Save 
Palette command. 

Choosing this command is the same as clicking the Palette button.

Note: This command is available only if your video capture board supports 8-bit video. 

Option Description

Colors Specifies the number of colors for the palette. The default is 236 colors, which allows Windows to 
use its 20 reserved colors. 

Frames Specifies the number of frames that DVP Capture should sample to build the palette. Sampling 10 to 
30 frames can produce a palette that doesn't contain substantial changes in color. 

Tip: If your video source contains many color shifts, choose the segment of video you use to create a palette 
carefully, keeping in mind that the palette will be applied to all the video that you capture at 8 bits. Because DVP 
Capture applies the new palette to the source video, you can preview the effect of the palette you capture in the 
preview window. To do so, you must check Preview Mode on the Options menu, and select either 8-Bit Palettized 
or 8-Bit Dithered for the video format (choose Video Format from the Options menu). 



Settings 
Capture menu (DVP Capture)

Displays options for capturing video.

Option Description

Frame Rate Specifies the number of frames per second (fps) to be captured. A rate of 30 fps 
is equivalent to the American television frame rate. The default rate of 15 fps is 
the maximum that Video For Windows can play on a system without a video 
board installed. A frame rate under 15 fps tends to create jerky motion, 
depending on the action in the source video.

Enable Capture Time Limit Specifies a time limit (in seconds) for the capture.

Capture To Memory Specifies that DVP Capture stores as many captured frames as possible in 
memory. When it has used all available memory, it begins storing captured 
frames on the hard disk.

Capture To Disk Specifies that DVP Capture stores captured frames on the hard disk. Capturing 
to disk takes longer than capturing to memory and so better suited for video 
with a small frame size or low frame rate.

Escape Key Specifies to press the Esc key to end video capture.

Left Mouse Button Specifies to click the left mouse button to end video capture.

Right Mouse Button Specifies to click the right mouse button to end video capture.

Enable MCI Capture If you have an MCIVCR-compatible video device installed on your system, 
check this option to use the Media Control Interface (MCI) for video device 
control. This option is available only if an MCI device driver is installed on your 
system.

Capture Audio When checked, audio is captured with the video. When unchecked, no audio is 
captured.

MCI Settings Opens the MCI Capture dialog box, in which you specify options for capturing 
video using an MCI video device. This button is available only if an MCI device 
is installed on your system.




